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1Introduction

I N T R O D U C T I O N

One of the reasons why computers have become a popular feature of industrial
activity is their ability to display and monitor signals from the real world. This
ability allows us to obtain data from our surroundings swiftly and efficiently.

The unit shown in this manual composed of the SAD450 or SAD450M interface
and KAPTORIS software is a data acquisition system for general use.

This unit has been designed for use in laboratories / electrical or electronic labs
for analysis of both digital and analog systems. It is so flexible that it can be
used for a number of applications, as follows:

- Analysis of digital circuits.

- Analysis of analog circuits.

- Computer-controlled processes (digital and analog).

- ...etc.
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The KAPTORIS programme has been developed for use as a tool which provides
pick-up programming and the display and processing of analog and digital signals.
The signals are picked up via the SAD450 data acquisition system developed
by Alecop.

Once they have been picked up, the signals may be subjected to a number of
processing systems, and this allows them to be examined by a number of signal
processing methods.

The results obtained may be displayed in a number of peripherals and in various
formats.

The first part of this manual describes the characteristics and the installation of
the SAD450 interface, the KAPTORIS software and its fittings.

The second part explains the general working guidelines to be observed for data
pick-up with the SAD450 using KAPTORIS.

The following sections provide an explanation of each and every option in the
programme.

The last section provides a number of working examples.

The annex dealing with the SAD450 interface programming commands allows
the user to create his own software with ease.
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C H A P T E R

1

Data acquisition interface

Introduction

The SAD450 series is composed of two data acquisition systems with similar
technical specifications but in two different formats.

The first of these systems, the SAD450, is a table format (Figure 1) designed for
applications of general use.  Consist s of the following:

- SAD450 Interface
- Power supply
- Connection cable to PC by means of an RS232C serial line
- Mains connection cable for power supply

The system is equipped with a 64-point connector where are available all the
inputs/outputs of the equipment. For its connection with the outside will have
to be used some of the accessories designed by ALECOP, they are described
ahead in this chapter or it will have to design some special accessory that can be
connected with the application of the user.

Figure 1
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The second system, the SAD450M, is in ALECOP module format and requires of
a frame/stretcher for its installation. This equipment has the connections of
inputs / outputs in 2mm connection sockets to be able to connect it quickly with
the equipment to analyze.  In addition to this, it  hasn’t got power supply because
it take advantage of  the power supply available in the frame which feeds the
equipment in study.  It consists of the following elements:

- SAD450M interface.

- Connection cable to PC by means of an RS232C serial line

As it can be seen in figure 3 the module is divided in 8 blocks or channels, each
one of them with a different kind of  inputs/outputs and different nomenclature
if they are inputs or outputs (first letters of the alphabet for the inputs and last
letters  for the outputs):

* A Channel: 8 digital inputs
* C Channel: 2 analog inputs
* D Channel: 2 analog inputs
* E Channel: 2 analog inputs
* F Channel: 2 analog inputs
* W Channel: 8 digital outputs.
* Y Channel: 2 analog outputs
* Z Channel: 2 analog outputs

Each input channel, analog or digital, has a commutator to select if the input
signal comes from the connection socket (position H) or from the 64-point
connector (CN).  The outputs do not have any selector and will be accessible
from the connection sockets as well as from the 64-point connector at any
moment.

Figure 2
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Figure 4 shows the internal clock diagram of the acquisition system in anyone of
its two versions.

Figure 4
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The following are the main characteristics of the system (for more detailed
information on the various inputs and outputs, consult the technical
specifications in this chapter):

- This is an “intelligent” SAD controlled by a µC Dallas 80C310 operating
with a 22.1184 Mhz internal oscillator. This characteristic provides
independence for pick-ups, and it is not necessary for the computer to be
permanently connected to the unit.

- Communication with the computer is via an RS232C serial line and
commands in ASCII codes. This makes it much easier to design specific
new software applications which the user may wish to incorporate. The
manual contains an annex with the description of the SDA450 interface’s
communications protocol.

- The system has 64K bytes for data, of which approximately 60K bytes are
available to store pick-up data.

The arrangement of the inputs/outputs on the 64-point connector (Figure 3) is
as follows:

Pin Description Pin Description

1 + 5 volts (output) 2 + 15 volts (output)

3 + 5 volts (output) 4 + 15 volts (output)

5 + 5 volts (output) 6 + 15 volts (output)

7 Ground (digital GND) 8 - 15 volts (output)

9 Ground (digital GND) 10 Analog output 3 (channel Z.1)

11 Analog output 4 (channel Z.2) 12 Analog output 1 (channel Y.1)

13 Analog output 2 (channel Y.2) 14 Fast-count input 0

15 Fast-count input 1 16 Digital output 9 (channel X.1)

17 Digital output 10 (channel X.2) 18 Digital output 11 (channel X.3)

19 Digital output 12 (channel X.4) 20 Digital output 13 (channel X.5)

21 Digital output 14 (channel X.6) 22 Digital output 15 (channel X.7)

23 Digital output 16 (channel X.8) 24 Digital output 1 (channel W.1)

25 Digital output 2 (channel W.2) 26 Digital output 3 (channel W.3)

27 Digital output 4 (channel W.4) 28 Digital output 5 (channel W.5)

29 Digital output 6 (channel W.6) 30 Digital output 7 (channel W.7)

31 Digital output 8 (channel W.8) 32 Ground (analog GND)

33 Analog input 7 (channel F.1) 34 Ground (analog GND)

35 Analog input 8 (channel F.2) 36 Ground (analog GND)

37 Analog input 2 (channel F.1) 38 Ground (analog GND)

39 Analog input 1 (channel C.2) 40 Ground (analog GND)

41 Analog input 4 (channel D.2) 42 Ground (analog GND)

43 Analog input 3 (channel D.1) 44 Ground (analog GND)

45 Analog input 5 (channel E.1) 46 Ground (analog GND)

47 Analog input 6 (channel E.2) 48 Ground (analog GND)
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CONVERSION TIMES:

- Fmax 1 analog channel: 200 Khz

- Fmax 2 analog channels: 62.5 Khz

- Fmax N analog channels: (1/((N*7mS)+10mS))

- 3 channels: 32.2 Khz

- 4 channels: 26.1 Khz

- 5 channels: 22.2 Khz

- 6 channels: 19.2 Khz

- 7 channels: 16.9 Khz

- 8 channels: 15.1 Khz

- Fmax 1 digital channel: 333 Khz

- Fmax 2 digital channels: 166 Khz

Figure 5

49 Digital input 15 (channel B.7) 50 Digital input 16 (channel B.8)

51 Digital input 13 (channel B.5) 52 Digital input 14 (channel B.6)

53 Digital input 11 (channel B.3) 54 Digital input 12 (channel B.4)

55 Digital input 9 (channel B.1) 56 Digital input 10 (channel B.2)

57 Digital input 7 (channel A.7) 58 Digital input 8 (channel A.8)

59 Digital input 5 (channel A.5) 60 Digital input 6 (channel A.6)

61 Digital input 3 (channel A.3) 62 Digital input 4 (channel A.4)

63 Digital input 1 (channel A.1) 64 Digital input 2 (channel A.2)



8 KAPTORIS.  Operator’s manual

Installation of the unit

The installation of the unit, in anyone of its two versions, is quiet simple, and the
only requirement is a computer with a free RS232C serial line (figure 6).

SAD450 table system

The steps to follow for correct installation of the unit are as follows:

1. Connect the serial line cable to the SDA450 interface and the computer
serial line (COM1 or COM2).

2. Connect the power supply to the SAD450 unit. The power supply
connector is at the back of the unit (Figure 1).

3. If the user has the SAD451 adapter, this should be connected to the unit
using the 64-point connector. If the user has another adapter, this should
always be connected to the unit before the power supply is switched on
to prevent damage to both units.

4. Finally, hook up the mains power supply and turn the unit on using the
switch at the rear.

SAD450M module system

1. If you have a frame with power supply, turn off the power supply of the
frame.

2. Hang the module in the frame.

3. Connect  the serial line cable to the SAD450M interface and the computer
serial line (COM1 or COM2).

4. Turn on the power supply that feeds the frame/stretcher.

Once it has been properly installed, KAPTORIS software should be installed as
per chapter 2 of this manual.

Figure 6
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Technical specifications

This technical specifications are valid for the two different versions of the system
except the ones which are marked as specific properties of one of them.

Analog inputs:

- Number of channels: 8 Single Ended or 4 differentials

- Type of ADC: Successive approximations

- Resolution: 12 Bits

- Maximum sampling frequency: 200 Ks/sec.

- Range of input voltages (may be selected via software)

- Input coupling: DC

- Maximum operating voltage: ±12 V. with respect to earth

- Surge protection: -20V ̧  +40V with Power ON
-35V ̧  +55V with Power OFF

- Input impedance: 1012  ΩΩΩΩΩ, Power ON
>5MΩΩΩΩΩ, Power OFF

- Recommended warm-up time: 15 minutes

- Set-up time:  3 µ µ µ µ µsecs.

Analog outputs:

- Number of channels: 4 channels

- Resolution: 9 Bits (8 bits + Sign)

- Maximum refresh frequency: 58 Ks/Sec.

- Output range: ±10 V.

- Output impedance: Maximum 1ΩΩΩΩΩ (100 Khz)

- Output current: 11 mA maximum

Gain Range

0.25 ± 10 V.

0.5 ± 5 V.

1.25 ± 2 V.

2.5 ± 1 V.

5 ± 0.5 V.

12.5 ± 0.2 V.
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- Protection: Short circuit to ground

- Set-up time: 3 µSec. for ±1 LSB precision

- Slew rate: 13 V/µSec.

Digital inputs:

- Number of channels: 2 x 8 bit channels (16 digital inputs).  The
SAD450M module version has only accessible one of these channels (8
digital inputs) trough connection sockets. In the 64-point connector there
are available the two channels.

- Compatibility: TTL/HCMOS

- Maximum reading frequency: 333 Ks/Sec.

Digital outputs:

- Number of channels: 2 x 8 bit channels (16 digital outputs). The
SAD450M module version has only accessible one of these channels (8
digital outputs) trough connection sockets. In the 64-point connector
there are available the two channels.

- Compatibility: TTL/HCMOS

- Maximum refresh frequency: 58 Ks/Sec.

Consumption:

Dimensions:

- SAD450: 230x35x145 mm (length x height x width)

- SAD450M: 215x250x147mm (length x height x width)

Connections with the exterior:

- Connection to the PC: RS232C serial line, 115200 Bauds

- Power supply (SAD450): DIN 41524 connector
(SAD450M): Frame’s connector

- I/O connector: 64-point connector

SAD450 SAD450M

5V 210 mA -

+15V 50 mA 162 mA

-15V 70 mA -



11Chapter 1.  SAD450 data adquisition interface

Unit accessories

The following is a description of the various accessories currently available for
the SAD450 data acquisition system. This cannot be a complete list of accessories
since new accessories / conditions are constantly being developed for the unit.
The user is advised to consult ALECOP for updated documentation.

Some of the accessories currently available for the unit are as follows:

- SAD451: Adapter to 2 mm connection sockets for all the unit’s inputs /
outputs.

- SAD452: Adapter to 2 x 37-pin Delta connectors for all the unit’s inputs /
outputs.

- SAD430: Adapter to screw connection for a block of 8 digital inputs.

- SAD431: Adapter to screw connection for a block of 8 digital inputs.

- SAD460:  Adapter for assembly of prototypes for analog inputs.

- SAD461: Adapter to screw connection for a block of 2 analog inputs.

- SAD462: Adapter to BNC connection for a block of 2 analog outputs.

SAD451

This interface is an adapter to 2 mm connection sockets for all the inputs and
outputs in the SAD450 data acquisition system. Figure 5 shows the interface
divided into 8 blocks or channels, each with a certain type of input and output,
and with differing nomenclature depending on input or output (first three letters
for inputs and the last three for outputs):

- Channel A: Corresponds to 8 digital inputs

- Channel B: Corresponds to 8 digital inputs

- Channel C: Corresponds to 2 analog inputs

- Channel D: Corresponds to 2 analog inputs

- Channel E: Corresponds to 2 analog inputs

- Channel F: Corresponds to 2 analog inputs

- Channel W: Corresponds to 8 digital outputs

- Channel X:  Corresponds to 8 digital outputs

- Channel Y: Corresponds to 2 analog outputs

- Channel Z: Corresponds to 2 analog outputs
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In addition to all the interface’s input and output connections, the upper right-
hand side of the unit has 3 mains outputs with ground connection sockets.
These outputs may be used to power other applications the user wishes to
connect to the data acquisition system without using another power supply.
The electrical characteristics of these outputs are as follows:

- +5 Volts/2 Amps

- +15 Volts/1.5 Amps

- -15 Volts/0.2 Amps

and all the outputs have short circuit protection.

SAD452

Adapter to 2 x 37-pin Delta connectors for all the units inputs and outputs. This
adapter will allow the user to prepare his own applications for swift connection
to the data acquisition system. To do this, depending on the number of the
application’s inputs and outputs, the user uses one or two 37-pin DELTA
connectors, with all inputs or outputs to be picked up or generated pre-cabled.
the interface is supplied with two DELTA connectors for connection to the
application.

Each DELTA connector has half the unit’s inputs/outputs, i.e. 8 digital I/O, 4
Analog inputs, 2 Analog outputs and 1 fast-meter input.

Figure 7
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The arrangement of the inputs/outputs on the connector is to be found on the
module’s plate.

SAD430

Adapter to screw connection for a block of 8 digital inputs. This adapter allows
connection of the signals to be picked up by screw terminals, and also has LEDs
showing the status of the digital inputs.

Figure 8

Figure 9
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SAD431

Adapter to screw connection for a block of 8 digital outputs. This adapter allows
connection of the signals to be picked up by screw terminals, and also has 8
LEDs showing the status of the digital outputs.

SAD460

Adapter for assembly of prototypes for a block of 2 analog inputs. This adapter
allows the user to design conditioners for the analog inputs. The bottom section
of the module shows where the +5V, +15V, -15V and GNDD supply signals are
located (GNDD is the ground signal for the digital part). The top section shows
the connection points for the two analog inputs, and the GNDA analog ground.

Figure 10

Figure 11
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Particular care must be taken in the design of the conditioners with regard to use
of the GNDD and GNDA grounds. Although both are connected to the power
supply, they are separate with respect to the circuit to prevent, as far as possible,
interference created by the digital circuit on the analog circuit.

It is for this reason that the design of the signal’s conditioning circuit will use
the analog ground. If for any reason a digital device is to be used for switching,
this must take its ground from the GNDD digital ground.

SAD461

Adapter to screw connection for a block of 2 analog inputs. This adapter allows
the user to connect the analog inputs using screw terminals.

SAD462

Adapter to screw connection for a block of 2 analog outputs. This adapter
allows the user to connect the analog outputs using screw terminals.

Figure 12

Figure 13
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Figure 14

SAD463

Adapter to BNC connection for a block of 2 analog inputs. This adapter allows
the user to connect the analog inputs using BNC connectors. The input
impedance of this module has been adapted to 1MΩ ±1% and 20pF in order to
use oscilloscope probes for entry of analog signals.



17Chapter 2.  KAPTORIS Software

C H A P T E R

2

KAPTORIS Software

Introduction

The Kaptoris system has been designed to ease the configuration and
programming of the SAD450 and SAD450M interfaces, and to carry out detailed
analysis of the data using tables and numerical data, and also in graph format.

Some of its characteristics are as follows:

- It allows configuration of the of the SAD450 and SAD450M interfaces
channels in simple visual fashion.

- The graphs showing the signals picked up adapt automatically to the
data they contain, but they may also be configured manually.

- The user has easy access to all pick-up details.

- Kaptoris allows the user to work with no connection to the unit.

- The reports produced by Kaptoris may include the graph, data tables
and specific comments for each pick-up.

- The programme allows the user to create new signals from those already
existing, using a signals calculator.

Hardware and software requirements

These are the minimum requirements for the PC in which the KAPTORIS system
is to be installed:

- 80486 processor or better

- 8 Mb of RAM
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- 5 Mb of available memory on the hard disk.

- Operating system, Windows 95/98/NT

- SVGA graphics board. Resolution 800X600 pixels.

- The user is advised to configure over 256 colours for the screen.

- Serial line communications port available.

Installation

The KAPTORIS application is installed using CD supplied with the unit. (Figure
15)

The following steps must be observed for installation of the programme:

1. Put installation CD into the CD drive.
2. The application will be executed automatically when the CD is inserted.
3. In case this option is turned off, the “Install.exe” file must be executed.
4. The first step is to choose the language.

Figure 15

Figure 16
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5. Choose “Install KAPTORIS”. You can also display user’s manual in PDF
format. (Figure 17).

6. The second window informs the user that the system is proceeding with
installation, and provides the cancel option again by clicking on Cancel.
The third window appears when the user clicks on Next (Figure 18).

Figure 17

Figure 18
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7. The third window shows the directory in which KAPTORIS is to be
installed. If you wish to change this, click on Search to access the directory
tree. Select the directory required and click on Accept to return to the
third installation window. The directory selected will appear where the
screen displayed “C:\Kaptoris” before. Click on Next for the fourth window
(Figure 19).

8. In the fourth window the installer is ready to begin copying the files to
the hard disk. Click on Next to enter the window showing progression of
the installation. Click on Cancel to exit installation (Figure 20).

Figure 19

Figure 20
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9. Copying the files to the hard disk may be cancelled by clicking on Cancel
in the progression window (Figure 21).

10. When installation has been completed, the last window appears to confirm
that the installation has been successfully completed (Figure 22).

10. In the event of an error during installation, start the process again from
the beginning.

12. KAPTORIS has now been installed in the PC. The installer creates a
group of programmes called “ALECOP Kaptoris”, and this menu contains
three direct accesses.

- KAPTORIS

- Kaptoris help

Figure 21

Figure 22
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Uninstalling KAPTORIS

KAPTORIS may be uninstalled in two ways, as follows:

- Execute the “Unwise.exe” file inside the directory of the programme.

- Use the Windows “Add or eliminate programmes” option on the control
panel. Here the user must select “KAPTORIS” from the list of programmes
and uninstall it by clicking on Accept.

Either of these methods may be used to completely eliminate KAPTORIS from
your system.
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C H A P T E R

3

Operating norms

Working with Kaptoris is a simple process, but the user should have an idea of
the main steps to follow to allow him to use this programme before a detailed
examination is provided of all its possibilities.

Kaptoris has been designed to help the user to analyse any type of system
using the data picked up.

- A pick-up is a record of data collected at regular intervals of a certain
duration.

Work with the data acquisition unit may be divided into four phases, as follows:

1. Configuring

Defining the channels of the of the SAD450, or SAD450M, interface
which will take part in the pick-up and the time parameters (Analysis time
and Sampling time).

2. Programming the pick-up

This consists of informing the SAD 450 or SAD450M interface as to the
configuration defined for the channels. When a pick-up is programmed,
its activation method is also defined. This may be carried out by a trigger
or by a period of time.

3. Displaying the result

Once the SAD 450 or SAD450M interface has completed the pick-up
procedure, the data obtained have been stored in its memory. To display
the data and work with them, the user must read them. Once they have
been read they are automatically transformed into signals on a graph.

4. Working with the signals

The user may work with the set of signals obtained by carrying out
operations, displaying all their details, adding more signals from a file,
printing reports etc.
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N.B.: Kaptoris allows the signals obtained to be saved, and allows the user to
work with them with no connection to the SAD 450 or SAD450M interface.

Starting the session

When the user starts a work session with Kaptoris, the software carries out a
number of automatic tests, as follows:

- Location of the serial port to which the SAD450/SAD450M interface is
connected

If the interface is not properly connected, the programme informs the
user of this situation and provides two options: attempting to carry out
the connection again or working with the section for analysis and
processing of signals only. The latter option means that the user cannot
carry out any further pick-ups or read interface data.

- Status of the SAD 450/SAD450M interface

Should communications be incorrect, the system carries out tests to
check whether the interface is:

1. Picking up data, i.e., a pick-up is in progress.

2. In stand-by mode with the data from the last pick-up stored in its
memory.

3. In stand-by mode with no data to be read in its memory.

- It also tests the amount of memory and the version of the interface.

Once the programme has completed the initial test procedure, the user may start
work with Kaptoris.

Examples of execution

Example 1
This example shows the steps to be followed to configure two input signals
and two output signals, carry out the pick-up procedure and display the results
thus obtained.
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The user must first configure the inputs and outputs which will take part in the
pick-up procedure. He selects the Configure I/O option on the configuration
menu, or clicks on the I/O button on the tool bar. According to the type of
interface which we are working with, will appear a window of configuration
of inputs / outputs or other. In this window (Figure 23), there are represented
all the inputs and outputs the SAD450 interface, divided in analogical and
digital.

In this other window (Figure 24), there  are represented all the inputs and outputs
of the SAD450M interface divided also in digital and analogical.

Figure 23

Figure 24
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The inputs which will take part in the pick-up procedure are: digital input A1 and
analog input C1.

In both windows, on clicking the button “1” on the section dealing with digital
inputs, and the name of the input appears by default, “indigA1” in this case.
When renaming the signal, the new name should be of significance (Figure 25).

Write «PrimeraD» and click on Accept . Position the mouse pointer over the
button, and the new name of the input appears in a small yellow box (Figure 26).

Finally, once the name of the signal has been defined, click on the verification
box to activate the input (Figure 26).

To define the properties of the number C1 analog input, the user clicks on the
appropriate button on the window section dealing with analog inputs. When
the user clicks here, a window appears for definition of properties (Figure 27).

Figure 25

Figure 26

Figure 27



27Chapter 3.  Operating norms.

An analog input has four properties, as follows:

1. The name, to a maximum of eight characters.

2. The range, which limits the values of the signal. E.g.: if we select ±5,
values over 5 volts or less than -5 volts will adapt to these threshold
values.

3. Units is the name of the units in which the signal is measured. By default
the units are Volts, but the user may change these by applying a
conversion factor - calibration.

4. Calibration defines the value by which the signal will be multiplied to
convert it into other units. The signals picked up are in volts, and to
convert them to more representative units the user employs a
multiplication factor. The calibration value is always a multiple of the
value of the signal and will have a maximum of 7 digits, including the
minus sign and the decimal point. By default its value is 1.

The only property we will change will be the name “SegundaA”. When the user
clicks on Accept, the analog input is configured in volts with a range of ±10 and
a calibration value of 1, since the values are taken by default. The user must now
click on the box to activate the input (Figure 28).

The next step is to define the output signals, the number W1 digital output and
the number Y1 analog output.

The properties of an output may be defined in two ways: by clicking on the
button associated with the output and, if the output has not been configured,
by clicking on its verification box. In both cases Kaptoris shows the properties
window.

The user clicks on the button associated with the number W1 digital output on
the section of the window dealing with digital outputs W. A window opens
showing the properties of the output (Figure 29).

Figure 28
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- A digital output has two properties, as follows:

1. The name, to a maximum of eight characters.

2. The generator defines the type of signal to be produced by the
output. There are three types of digital generators: Train, Pulse
and Table. A generator must be assigned in order to activate the
output (the generators are explained in more detail in the
manual’s analog outputs section).

In the case of digital output W1, the name by default is “OutDiW1”, and in this
case it will not be changed. The generator to be assigned to this output will be
the pulse type. To define the parameters for this generator, the user clicks on the
Pulse button in the properties window (Figure 30).

Figure 29

Figure 30
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A high pulse is a signal which, having remained at logical «0» over a delay time
To, moves to logical «1» until the analysis time has elapsed.

A low pulse is a signal which, having remained at logical “1” over a delay
time To, moves to logical “0” until the analysis time has elapsed.

In this case we must define a delay time of 1 second, and the type of pulse will be
high. When the user clicks on Accept, the window showing the parameters of
the pulse closes and the generator has been defined. An icon now appears on
the button to show the type of generator selected (Figure 28).

The user clicks on the verification box for digital output W1, and this activates
(Figure 31).

Now the user must define analog output Y1. To display its properties, he clicks
directly on the verification box. Since this output has not yet been defined, the
properties window opens straightaway (Figure 32).

Analog outputs have two properties, as follows:

1. The name, to a maximum of eight characters.

2. The generator defines the type of signal to be produced by the output.
There are four types of analog generator: Step, Seno, Ramp and Table.
A generator must be assigned to allow the output to be activated.

In the case of analog output 1, the name “SalAna1” remains the same, and a step
generator is defined. The user accesses its parameters by clicking on the Step
button (Figure 33).

Figure 31

Figure 32
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A step is a signal which, having remained at a value Ao over delay time To,
suddenly changes to a value A1 until the analysis time has elapsed.

In this case a value of 1 second must be assigned as delay time (To), -2 volts will
be the offset amplitude (Ao), and 6 volts the step amplitude (A1). The user clicks
on Accept to define the output, and the system returns to the configuration
window.

The next step is the definition of times. The user must define the total pick-up
time for signals, known as analysis time, and the time between pick-up of one
sample and the next, or sampling time. Beside each of these values there are
two boxes showing a list of units with which the user may work (Figure 34).
Definition of these two values allows each of the signals picked up to be
defined by a number of data. The higher the number of data defining a signal,
the higher the degree of accuracy, but the time for representation and
calculation will also be longer.

Below these boxes is another box showing the number of samples. This value is
automatically recalculated whenever a time changes (Figure 34).

The Fastest pick-up button calculates threshold times during which the SAD
450 may be configured (Figure 34).

The first example will define an analysis time of 2 seconds, and a sampling time
of 10 milliseconds, and this will provide 201 data per signal (one more datum is
added since pick-up is carried out for the first sample in second 0 - Figure 34).

Figure 33
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The two boxes which remain to be defined are:

- Automatic naming: if this is activated, every time we read the signals of
a pick-up from the interface, the programme will name these
automatically. The name consists of the channel from which the signal
comes and the number of pick-ups we have carried out with the
configuration defined.

- Activate operations: When this box is activated, every time we read
pick-up data a signal will be generated for each operation defined
(Operations are covered at a later stage in the manual).

In this example it is not necessary to activate any of these boxes (Figure 35).

This window may also be used to define operations, but in this case we will not
define any. The two operations buttons are used to activate this option (Figure
36).

When the user clicks on Accept in this window, Kaptoris tests the configuration
defined. In the event of an incompatibility or an error, a warning message appears
and the user is taken to the configuration window again. If there is no problem,
the window closes and the configuration has been completed.

To allow this configuration of inputs and outputs to be used for other examples,
it is stored in the «ejemplo1.CFG» file. To store the configuration, click on Save
configuration on the Configuration menu, and a Windows dialogue box appears.
The user enters the name of the file «ejemplo1» and clicks on Save (Figure 37).

Figure 34

Figure 35

Figure 36
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Once the configuration has been defined and stored, prior to carrying out
pick-up of signals the user must ensure that the inputs and outputs are properly
connected.

In this example, the input signals will be the same signals generated by the
programme as output signals. Here the user must connect analog output Y1 to
analog input C1, and digital output W1 to digital input A2.

Pick-up may now commence. We will carry out an immediate pick-up, and this
means that pick-up commences as soon as it has been programmed. Kaptoris
can also carry out delayed pick-ups or trigger-activated pick-ups – all these
options are explained at a later stage in the manual.

There are two ways of activating the immediate pick-up window: by clicking
on the Prog. button on the tool bar, or clicking on the Immediate Pick-up
option on the Pick-up menu (Figure 38).

Figure 37
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The Immediate Pick-up window shows the times configured, and these may be
changed if the user so desires. In this case we will make no changes, and so the
user merely clicks on Accept. The window closes and pick-up commences. In the
event of a communications error with the SAD450, or SAD450M, Kaptoris informs
the user of this using error windows.

Should the user wish to know if pick-up has been completed, he may check the
status of the interface by clicking on the Test button on the tool bar, or on the
Test interface status option in the Pick-up menu on the main window (Figure
39).

When the 2 seconds of the pick-up have elapsed, the user must collect the data
from the interface memory. To do this, he may click on the Read button on the
tool bar, or on the Read results option in the Pick-up menu. The cursor turns
into an hour-glass until Kaptoris has completed its reading of the data via serial
line (Figure 40).

Once the reading has been completed, a graph window opens automatically to
show a colour representation of the four signals picked up. The names of the
signals and the colour representing them are shown to the right (Figure 40). The
user may modify the appearance of these graphs (grilles, scale, size of the pass
etc.) by clicking on the Define representation option.

Figure 38

Figure 39
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At this point the set of signals should consist of the following: PrimeraD,
SegundaA, SalDig1 and SalAna2.

The user may select the signals which appear on the active representation by
clicking the Select signals option in the Representation menu or on the Select
button on the tool bar. A window appears with two lists. The left-hand list
contains the signals which do not appear on the active graphic representation.
This list is empty.

The right-hand list contains the four signals picked up, and this is the list featuring
the signals displayed (Figure 41). The user wishes to leave only the two analog
signals on the representation, and so he selects the digital signals and clicks on
the “<<“ button. The two digital signals should now appear on the list of signals
not displayed.

Figure 40

Figure 41
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When the user clicks on Accept, the graph window refreshes and shows only
the signals on the list of displayed signals.

There are two types of graph window: digital and analog. By default, the first
window to be created is always analog (Figure 40). The user clicks on the Digital
option on the tool bar or on the New digital window option in the Window menu,
but in this case the system will show only the digital signals. Saldig1 and
PrimeraD will appear one on top of the other, with values 0 and 1 (Figure 41).

If the graphic representation windows are superimposed, the user may click the
Horizontal option in the Window menu and the windows will organise themselves
horizontally on screen.

The graphic representation windows have an emerging menu which appears
when the user clicks the right-hand button on the mouse. This small menu
contains three commands. Zoom - and Zoom + allow the user to enlarge areas on
the graph and then return to the normal graph size (Figure 40). The Cursors
option activates a section of the window which was previously concealed  (Figure
43).

Figure 42

Figure 43
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- Each graphic representation has two cursors, one red and one blue. A
cursor is a vertical line which may be positioned on any part of the
graph. The value at which it cuts through the X axis and the value on
the Y axis for each of the signals appear on the table at the bottom of the
window. The red cursor is positioned by clicking the right-hand button
on the graph, and the blue cursor using the left-hand button. The table
also shows the difference between the values of both cursors (Figure
43).

- The user may wish to have more details concerning the data for the
signals obtained, add more signals from a previous pick-up operation,
export sample data or print out a report. All these options, among
others, are possible within the Kaptoris system, and are discussed in
other sections of the manual.

- The final stage of this example consists of saving the set of signals and
the configuration in a KPT file, i.e. saving the pick-up.

- The user clicks on the Save button on the tool bar or on the Save option
in the File menu, and the Windows Save dialogue box appears. The name
of the file may be “ejemplo1”. When the user clicks on Accept the pick-up
is saved for subsequent use (Figure 44).

Example 2

This second example defines the steps to be taken to display the signals.

In this pick-up mode the computer simulates operation of a memory oscilloscope
by picking up the signal and displaying it simultaneously. When the display has
been completed, the signals picked up are stored in the memory of the SAD 450/
SAD450M interface, and may thus be retrieved by Kaptoris.

The user requires an external signal generator for this example.

As in the previous example, the first step is configuration of the input and
output channels which are to participate in the pick-up. To make the example
easier, we will configure only one analog input.

Figure 44
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The user selects the Configure I/O option in the configuration menu, or clicks
on the I/O button on the tool bar ,and, if we are working with the SAD450
interface the “Configuration of I/O-SAD450M”  appears (Figure 45), otherwise
the n  “Configuration of I/O-SAD450M” window will appear (Figure 46).

If the user has carried out example 1, analog input C1, digital input A1, digital
output W1 and analog output Y1 will be active on the window. All active inputs
and outputs must be disactivated except for analog input C1 by clicking on the
boxes. If the user has only recently started to use the programme, the window
will be clear with all inputs and outputs disactivated. In this case analog output
Y1 must be activated by clicking on its box (Figure 47).

Figure 45

Figure 46
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The next step involves definition of pick-up times.

Continuous display programmes again and again the pick-up as defined, and
shows the data being picked up on a graph. The display and programming
loop terminates when the user presses Close window in the display window.

The user wishes to define an analysis time of 10 seconds and a sampling time of
100 milliseconds. This gives a total of 101 samples in 10 seconds, meaning that
the display graph will initialise again every 10 seconds (Figure 48).

The analysis time depends on the display required for the signal to be picked
up, i.e. when the analysis time as defined has elapsed, the window will be
deleted and the system will begin to display the signal again from the left-hand
side of the X axis.

Once the times have been defined, the user must select the option of the
programme for continuous display by clicking on Continuous display in the
Pick-up menu (Figure 49).

A window then appears to inform the user that the pick-up is being programmed.
Once the programming has been completed, the display window appears and
display of the current pick-up begins (Figure 50).

Figure 47

Figure 48

Figure 49
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When the user clicks on Close window, the display ends, but data from the last
analysis time remain in the interface memory, and so these may be retrieved.
Should the user wish to do so, he merely follows the procedure defined in the
first example to read interface data.

Figure 50
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C H A P T E R

4

Configuration of inputs
/outputs

Configuring a pick-up

Configuring a pick-up consists of defining the input and output channels to be
used in data pick-up.

The user accesses the configuration window via the Inputs/outputs option on
the Configuration menu.

This window may also be accessed by clicking on Configure I/O on the tool bar.

The first time this option is chosen, KAPTORIS shows this window (Figure 53),
in which you have to choose the type of interface which you are going to work
with by clicking on the corresponding option and then on the “OK” button.

You can change this setting later. (See subject "How to change the appearence
of the I/O window").

Figure 51
"Inputs/Outputs option

on the Configuration
menu"

Figure 52
"Configure I/O" button
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If we are working with SAD450 interface this window will appear, it represents all
the channels and configuration options of the interface.

The channels are divided as follows:

- Digital inputs A 1-8
- Digital inputs B 1-8
- Analog inputs C 1-2
- Analog inputs D 1-2
- Analog inputs E 1-2
- Analog inputs F 1-2
- Digital outputs W 1-8
- Digital outputs X 1-8
- Analog outputs Y 1-2
- Analog outputs Z 1-2

Figure 53

Figure 54
"Configuration of I/O-

SAD450" window
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In case you were working with SAD450M interface, the window would be this
(Figure 55).

The channels are divided in:

- Digital inputs A 1-8
- Analog inputs C 1-2
- Analog inputs D 1-2
- Analog inputs E 1-2
- Analog inputs F 1-2
- Digital outputs W 1-8
- Analog outputs Y 1-2
- Analog outputs Z 1-2

To activate an input or output channel, the user must proceed as follows:

- Define its properties. The user accesses these by clicking on the button
associated with each channel. The properties depend on the type of
channel. All channels have a name by default, and this may be modified.
The name of the channel will be that which the signals take once they
have been picked up or generated by the SAD 450, or SAD450M.

- If more than one pick-up is to be carried out with the same configuration,
the user must activate the Automatic naming box. In this way the
programme will provide different names for signals picked up by the
same channel automatically. The name of the signals consists of the
channel from which the signal originates and the number of pick-ups
carried out to date.

- Activate the channel. To do this, the user simply clicks on the appropriate
verification box, whereupon a cross appears. To disactivate the channel,
the user clicks the box again.

Figure 55
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To configure the pick-up times, the user must define the value of two parameters:
the sampling time and the analysis time. With the SAD450 they are defined in the
boxes on the left-hand lower section of the window, and with the SAD450M in
the boxes on the right –hand top section of the window.  (For more information,
consult "Defining Times").

The lower section also features two buttons used to move on to definition of
digital and analog operations.

- Operations may be activated or disactivated by clicking on the Activate
operations box.

If the user clicks on the Clear button, all channels are disactivated, the names
are deleted, and any generators we have defined for the outputs are removed.
The entire configuration initialises.

The configurations may be stored in files for subsequent use, thus avoiding
unnecessary repetition of the definition of the configuration.

If the user clicks on Cancel, he exits the window without saving the changes
made to the configuration.

If the user clicks Accept and the configuration is correct, there are two possible
reactions:

- If the configuration is compatible (the times do not change) with the
previous configuration, or if we are defining it for the first time, the window
closes and the configuration defined will be that available henceforth.

- If the configuration is not compatible, a warning window will appear to
give the user the option of saving the configuration with which he was
working.

Loading a
configuration

To load a configuration from a file, the user must activate the Open configuration
file option in the main menu.

Figure 56
Image of button and box

associated with a
channel

Figure 57
"Open configuration

file" option on the
configuration menu
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A dialogue box will appear, allowing the user to select the file whose configuration
is to be loaded.

Configuration files have a CFG extension.

Once the right file has been selected and the user has pressed the Open button
on the dialogue box, a check is run as to whether the configuration is valid for
the current set of signals.

In the event of incompatibility, a message will appear asking the user whether he
wishes to save the set of data and the current configuration.

When the configuration is loaded, the inputs/outputs window appears
automatically to show the contents of the file.

Saving a
configuration

The configuration at any given time may either be saved together with the other
data, or separately.

If the user only wishes to save the configuration of the SAD450, or SAD450M
interface, he must select the menu option Save configuration file from the menu.

A Save dialogue box appears to provide a name for the file, and the file is saved
in the folder selected.

The configuration will be kept in a CFG file.

How to change
the appearance

of the I/O
window

Figure 58
"Save configuration

file" option on the
configuration menu

You can choose the appearance of the data acquisition system I/O configuration
window. First time you choose the option that activate the I/O window,
KAPTORIS shows you this other window (Figure 59) in which you have to
choose the type of interface you will work with.
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You have to click on the apropiate box an then on “OK” button.

You can also change the appearances of the  I/O window whenever you want
bay clicking the “Appearance of I/O window” on the configuration menu (Figure
60).

Digital inputs

Table SAD450 is equipped with 16 digital inputs, and SAD450M module is
equipped with 8. When the user clicks on the associated buttons, a window
appears to show the name currently used by the digital input.

To change the name of the input, the user simply writes the new name in the box
and clicks on Accept.

Figure 59

Figure 60

Figure 61
"Assign name" window
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If the name is a repeat, an information window appears to indicate this.

To activate the input, simply click on its box.

Analog inputs

The both interfaces, SAD450 and SAD450M, are equipped with 6 analog inputs.
When the user clicks on any of the buttons associated with the inputs, a window
appears showing the properties of the channel.

Analog inputs have four properties, as follows:

1. The name of the signal, to a maximum of eight characters.

2. The range, which limits the values of the signal.

3. Units is the name of the units in which the signal is measured. By default
the units are volts, but they may be changed by applying a conversion
factor to the signal, called calibration. The name of these units must be
defined in this property.

4. Calibration defines the value by which the signal will be multiplied (in
volts) to convert it to other units. Its value by default is 1.

Figure 62
Box for digital input 1

Figure 63
"Analog input data"

window
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It is also possible to carry out pick-up in differential mode by clicking on the
Diff. box. This always disables the second input of each pair. When the user
selects the first input, this creates a signal which will be the difference between
the two channels.

Differential input

A single-ended input is an input with reference to ground. However, in the case
of a differential input, a single-ended input refers to another single-ended input.

EA1, EA2: Single-ended

EA3: Differential

To activate an input, the user simply clicks on its box.

When the user clicks on Cancel, the changes made will not be saved in the
configuration.

When the user clicks on Accept, if the name is a repeat a message will appear. If
this is not the case, the window closes and the changes are made to the
configuration.

Digital outputs

Table SAD450 is equipped with 16 digital outputs, and SAD450M module is
equipped with 8. Each of these has an associated button which displays the
window showing its properties.

If the output has already been defined, the button will show a drawing of the
type of signal which will be generated via that channel.

When the user clicks on the button the following window appears:

Figure 64
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The digital outputs have two properties to be defined, as follows:

1. The name, to a maximum of eight characters.

2. The generator, defining the type of signal to be produced by the output.
There are three types of digital generators: Train, Pulse and Table. A
generator must be assigned to allow the output to be activated.

When the user clicks on Destroy generator, any generator assigned to the
output is removed.

When user clicks on Cancel, the window closes and the changes are not made
to the configuration.

When the user clicks on the Accept button, if all the properties are correct, the
window closes and the changes are reflected in the configuration.

Figure 65
"Configuration of

digital output" window
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Pulse
train This is the format of a digital generator known as a pulse train.

A pulse train is a square signal where times at 1 (logical) and at 0 (logical),
respectively, are determined by Ton and Toff.

The square signal is preceded by a logical 0, the duration of which is equal to the
delay time.

Total duration of the signal is the duration of the analysis time.

The parameters are as follows:

1. Delay time (To): this defines for how long the amplitude of the output is
“0”, and once this time has elapsed generation commences of the pulse
train.

2. Time at “1” (Ton): this defines the time during which the value of the
output is “1”, or is “On”.

3. Time at “0” (Toff): this defines the time during which the value of the
output is “0” or is “Off”.

Pulse
There are two types of pulse, as follows:

- High: this is a signal which, having remained at logical “0” over a delay
time To, moves to logical “1” until the analysis time has elapsed.

Figure 66
"Pulse train"

representation
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- Low: this is a signal which, having remained at logical “1” over a delay
time To, moves to logical “0” until the analysis time has elapsed.

Digital table
A table-type digital generator consists of a number of values which may be 0 or
1.

Figure 67
"High-pulse"

representation

Figure 68
"Low-pulse"

representation

Figure 69
"Digital table"
representation
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A delay time To may also be defined.

The values on the table are applied periodically at the rate of one for each
sampling time, after the delay time defined. Once all the values of the table have
been emitted, the sequence begins again.

The signal finishes when the analysis time has elapsed.

The tables are files with a TBA extension.

To select a table, the user clicks on the                           button. A dialogue box will
appear to allow the user to select a file.

The file selected will appear in the File name box.

If the user wishes to edit or create a table, he must click on the Table editor
button                                   . This activates the table editor.

Analog outputs

The both interfaces, SAD450 and SAD450M, are equipped with 4 analog outputs.
Each of these has an associated button to display the window showing its
properties.

Should the output already be defined, the button will show a drawing of the type
of signal which will be generated by that channel.

When the user clicks on the button, the following window appears:

Figure 70
"Configuration of

analog output" window
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The digital outputs have two properties to be defined, as follows:

1. The name, to a maximum of eight characters.

2. The generator defines the type of signal to be sent out at the output.
There are four types of analog generator: Step, Seno, Ramp and Table. A
generator must be assigned to allow the output to be activated.

When the user clicks on Destroy generator, any generator assigned to the
output is removed.

When the user clicks on Cancel, the window closes and the changes are not
made to the configuration.

When the user clicks on Accept, if all the properties are correct, the window
closes and the changes are reflected in the configuration.

Step
This is the format of a step-type analog signal.

A step is a signal which, having remained at a value Ao over the delay time To,
suddenly changes to a value A1 until the analysis time has elapsed.

The parameters are as follows:

1. Offset amplitude (Ao in Volts): this defines the amplitude of the step
over the delay time (To). Its value will be a real number within the ±10 volt
range.

2. Step amplitude (A1 in volts): once delay time (To) has elapsed, the step
will take the value of this parameter. As in the case of the Ao parameter,
its value will be a real number within the ±10 volt range.

Figure 71
"Step" representation
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3. Delay  (To): this defines the period of time during which the amplitude of
the step will be the value defined in Ao.

Senoidal
This is the senoidal-type analog signal.

The values of the boxes are used to define a senoidal signal of amplitude A1, and
period T1, preceded by a continuous component, value Ao, over delay time To.

The senoidal signal is assembled over the continuous component, and its
duration is equal to the analysis time.

The parameters are as follows:

1. Offset amplitude (Ao in volts): this defines the amplitude of the output
during the delay time (To). Its value must be a real number within the ±10
volt range.

2. Senoid amplitude (A1 in volts): once the delay time (To) has elapsed, a
senoid is generated, the peak-to-peak amplitude of which is defined by
double the value of this parameter. It must be a real number within the ±10
volt range.

3. Delay time (To): this defines for how long the amplitude of the output
signals is equal to the value defined as Ao.

4. Frequency (1/T1 hertz): this parameter defines the senoid’s frequency,
and T1 is its period.

Figure 72
"Senoidal"

representation
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Ramp
This is the format of a ramp-type analog signal.

A ramp is a signal which, having remained at value Ao over delay time To, has
gradually changed over a period T1 until it reaches the value A1, where it remains
until the analysis time has elapsed.

The parameters are as follows:

1. Offset amplitude (Ao in volts): this defines the amplitude of the output
during the delay time (To). Its value will be a real number within the ±10
volt range.

2. Ramp amplitude (A1 in volts): once the delay time (To) has elapsed, the
value of the output will rise or fall with the slope in such a way that, when
ramp time (T1) is reached, it will have reached the value of this parameter,
and remains at this value until pick-up has been completed. As in the
case of the Ao parameter, its value will be a real number within the ±10
volt range.

3. Delay time (To): this defines for how long the amplitude of the output
signal will be the value defined as Ao.

Figure 73
"Ramp" representation
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Analog table

An initial delay time To may likewise be defined.

The values of the table are applied periodically at the rate of one for every
sampling time, once the delay time has been defined.

The tables are files with a TBA extension.

To select a table, the user clicks on the                     button, and a dialogue box
appears to allow a file to be selected.

The file selected will appear in the File name box.

If the user wishes to edit or create a table, he must click on the Table editor
button                                    , and this activates the table editor.

Figure 74
"Analog table"
representation

A table-type analog generator consists of a series of real numbers representing
values between ±10 Volts.
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Table Editor

The table editor is extremely reliable, and allows the user to create and edit tables
with great ease.

The table editor has four options, as follows:

1. Edit table shows a dialogue box, Open, to allow the user to select the file
to be edited. This may be edited once it appears on screen.

2. New table clears the screen and allows data to be entered, thus creating
a new table.

3. Save table carries out the same procedure. In the case of a new table, it
shows the Save dialogue box which allows the user to select the file
name.

4. Save as … always shows the Save dialogue box to give the file a new
name and save the changes made.

The user clicks on Exit to close the table editor.

Defining the contents of the table

1. The Number of values box is used to specify the number of values which
the table will have.

2. Enter the values in the table to the left, one value for each box.

Figure 75
"Editor of digital/

analog tables" window
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3. Specify the type of table to be created in Type of table.

4. When this is saved, verification is carried out of the validity of the values,
depending on the type of table with which we are working.

Operations

In addition to the signals from the SAD450 interface input and output channels,
other signals may also be generated as the result of operations with the actual
input and output signals.

Each time a reading is taken of data from a pick-up, we can automatically generate
as many signals as operations we have defined.

Operations must always be between signals of the same type, i.e. an operation
between analog signals or an operation between digital signals. These signals
are generated during reading of the data, and thus cannot be used for pick-up.

If the Activate operations option in the configuration window is not activated,
the operations defined will not generate signals.

If the Activate operations option is activated, for each pick-up we carry out a
signal will be generated per operation defined.

These are affected by the automatic naming option (for more details, see
Configuring a pick-up).

Both digital and analog operations may be defined; in each case with different
operators between signals.

The difference between the Signals calculator and the operations is that the
operations are generated dynamically, whereas the calculator operates with
signals already picked up.

The user accesses definition of operations from the Configure SAD450 window
and clicking on the operations buttons.

Digital
operations

Figure 76
"Operations buttons"

The digital operations window is similar in appearance to a calculator.
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The two operand sections show the digital signals currently activated within
the configuration.

The central section shows the operators which may be applied.

Digital operations which have been defined are shown to the right.

The various digital operations which may be carried out are as follows:

The Add button adds the defined operation to the list of operations, whilst the
Delete button eliminates operations which we no longer wish to use.

To exit without saving the operations defined, press Cancel.

To exit the window and save the operations defined, press Accept.

Defining a digital operation

1. The user selects an operand from the Operand 1 list.

2. The user then selects an operator by clicking on the appropriate button.

3. In the case of an operation involving more than one operand, an operand
is selected from the Operand 2 list.

4. The Name and Unit boxes are automatically activated, as is the Add
button.

5. Define the name of the operation and the name of the units (Volts, by
default).

6. When the user clicks on Add, the operation and the expression which
represents it will appear in the list of Operations and Descriptions.

Figure 77
"Definition of digital
operations" window

AND OR NOR NAND XOR XNOR NOT
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Deleting a digital operation

1. The user selects the operation from the Operations list, and clicks on the
Delete button. The operation has been removed.

Analog
operations

The appearance of the analog operations window is that of a simple calculator.

The two operand sections show all the analog signals currently active within
the configuration.

The central section shows the operators which may be applied.

Digital operations which have been defined are shown to the right.

The various analog operations which may be carried out are as follows:

The Add button adds the defined operation to the list of operations, whilst the
Delete button eliminates operations we no longer wish to use.

To exit without saving the operations defined, press Cancel.

To exit the window and save the operations defined, press Accept.

Defining an analog operation

2. The user selects an operand from the Operand 1 list, or enters a value in
the Constant box.

3. The user clicks on the appropriate button to select an operator.

4. In the case of an operation involving more than one operand, an operand
is selected from the Operand 2 list, or a value is keyed into the Constant
box.

Figure 78
"Definition of analog
operations" window

- + * / f dx d/dt Filters
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5. The Name and Unit boxes are automatically activated, as is the Add
button.

6. Define the name of the operation and the name of the units (Volts, by
default).

7. When the user clicks on Add, the operation and the expression which
represents it will appear in the list of Operations and Descriptions.

Deleting an analog operation

1. The user selects the operation from the Operations list, and clicks on the
Delete button. The operation has now been eliminated.

Defining times

For any pick-up there are two time parameters, as follows:

- The analysis time or total time for the pick-up.

- The sampling time is the time which elapses between collection of one
sample and the next.

For both configuration and programming of the pick-up, there is an option to
change the sampling time and the analysis time.

The pick-up times or others selected will depend on the speed of the signal to be
picked up. In other words, if the evolution of the signal is slow, the analysis time
will be long, and vice-versa if its evolution is fast.

The value of the number of samples is calculated each time a change in made to
any of the two time parameters, and is the result of division of the analysis time
between the sampling time plus 1 (another sample is added since samples are
also taken during second 0 of the pick-up).

If the sampling time is short, the samples obtained are extremely close together
on the signal, whereas if this is long, the samples will be more spaced out. In
both cases we obtain an ordered collection of values.

Figure 79
"Definition of times"

representation
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The units of the time parameters may be selected from the pull-down lists to the
right of the boxes in which the times are defined. The units may be: seconds,
milliseconds, microseconds and, in the case of the analysis time, also minutes
and hours.

If the times defined are not correct, a warning window will inform the user of the
error.

Fastest possible pick-up

- When the user clicks on the Fastest pick-up button, the times are
configured automatically.

- When this button is pressed the user cannot write in the boxes used to
define the sampling time.

- The sampling time will adapt to the minimum time, depending on the
configuration of inputs and outputs.

- The analysis time will adapt to allow the maximum number of samples
depending on the memory of the interface.

- To disable this option, simply click on the button again.

Filters

The filters consist of specially designed systems which act on the signals to
obtain a certain frequency response, with the common objective of restricting
this response to a certain margin of interest.

The following are some of the most typical applications: suppression of
undesirable frequencies in the signals measured (general noise), separation of
components of a phenomenon for individual assessment, restriction of band
pass for the use of other treatments at a later stage (integration, diversion etc).

Depending on the signal upon which it acts, a filter may be analog or digital. If
the filter acts on an analog signal, it is called an “analog filter”. These filters
consist of items such as resistors, capacitors, amplifiers etc. On the other hand,
the term “digital filter” refers to the process or algorithm whereby a signal or
sequence of numbers is transformed into a second sequence of numbers, and it
is this type of filter which is used by the Kaptoris system.

The digital filter used transforms the signal from the time domain to the frequency
domain. In this domain, the components of the undesirable frequencies are
removed by application of a filter, and the time domain is accessed again. This
technique includes the use of the Fourier transforms and their implementation
by means of “Fast Fourier Transform” (FFT).

A filter allows one or more frequency bands to be transmitted whilst rejecting
signals whose frequency is not found on these bands. Definition of the pass
bands allows the following classification to be made:
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"Low pass" filters

These are filters which, above a given cut-off frequency, eliminate the
magnitude of the signal, and transmit frequencies below the cut-off point
unchanged

"High pass" filters

These are filters which, below a given cut-off frequency, eliminate the
magnitude of the signal, and transmit frequencies above the cut-off point
unchanged.

"Band pass" filters

When we combine the low pass filter with a high pass filter, we obtain what
is known as a “band pass” filter. This type of filter transmits a certain band of
frequencies, and removes the magnitude of the frequencies located outside
the band.

Figure 80
"Low-pass filter"

representation

Figure 81
"High-pass filter"

representation

Figure 82
"Band-pass filter"

representation
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Figure 84

"Stop band" filters

These filters may be used to remove the magnitudes of specific frequency
bands

Once the signal has been filtered, the FFT inverse (IFFT) is used to move it
to the time domain.

This is the window used to define the filter to be applied to the signal selected.

Following selection of the type of filter, a value must be provided for the
frequency or frequencies which the user wishes to apply.

The filter is applied when the user clicks on Accept.

Figure 83
"Stop band filter"

representation
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C H A P T E R

5

Pick-ups

What a pick-up is?

This section includes the steps taken from programming of the SAD450/SAD450M
interface to reading of the data via serial line and its initial interpretation.

- When programming a pick-up, Kaptoris informs the SAD450/SAD450M
interface as to the configuration which has been defined; i.e. the input /
output channels to be activated and their properties, analysis and
sampling times, and the way in which the pick-up is to be activated (by
time or by trigger).

- When the SAD450/SAD450M has received all the configuration data,
pick-up commences.

- Pick-up may be observed as it is being carried out using the Kaptoris
display options.

- Once pick-up has been completed, the data are stored in the SAD450/
SAD450M’s memory, and so data reading must be carried out. Kaptoris
requests the data from the interface, and the interface transmits the data
via serial line. The programme automatically interprets the information
received, and converts it into workable signals.

Programming a pick-up

When a pick-up is to be programmed, whatever method is used, any other pick-
up programmed is cancelled and any data stored are deleted. If this is the case,
a window provides information with regard to the status of the SAD450/SAD450M
interface and requests confirmation regarding continuity of the programming
process.

Four different types of pick-up may be carried out depending on the activation
method selected.
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Immediate
pick-up To access this type of pick-up, the user clicks on the Prog. button                  on

the tool bar, or on the Programme pick-up option and then on Immediate on the
Pick-up menu.

An immediate pick-up commences as soon as it has been programmed.

The window allows the user to redefine the times.

When the user clicks on Accept, a window appears requesting confirmation of
the pick-up.

Figure 85
"Programme immediate
pick-up option" on the

Pick-up menu

Figure 86
"Programme immediate

pick-up" window
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This will disappear as soon as the programming has been validated by the
SAD450 interface; otherwise a window will appear to indicate a communications
error.

Between programming of an immediate pick-up and the first reading of the data,
an icon appears on the status bar.

If the user wishes, he may display the pick-up whilst this is being carried out.

When the user clicks on Cancel, any changes made to the times will not be
reflected in the configuration and the window duly closes.

Delayed pick-
up

Figure 87
"Waiting for interface

response" window

Figure 88

To access this type of pick-up the user clicks on the Programme pick-up option,
and then on Delayed on the Pick-up menu.

A delayed pick-up commences after a time delay To (in seconds) following
programming.

Figure 89
"Programme delayed

pick-up" option on the
Pick-up menu
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The top box is used to define the delay time in seconds. If a delay time of 0
seconds is programmed, this pick-up will be no different from an immediate pick-
up.

The window may be used to redefine the times.

When the user clicks on Accept, a window appears to request confirmation of
the pick-up.

If all is well, this will disappear as soon as the programming has been validated
by the SAD450 interface; otherwise a window will appear to indicate a
communications error.

Figure 90
"Programme delayed

pick-up" window

Figure 91
"Waiting for interface

response" window
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Between programming of a delayed pick-up and the first reading of the data, a
chronometer icon appears on the status bar.

If the user wishes, he may display the pick-up whilst this is being carried out.

When the user clicks on Cancel, any changes made to the times will not be
reflected in the configuration and the window duly closes.

Analog
trigger

Figure 92

To access this type of programming, the user clicks on the Programme pick-up
option, then on Trigger, and finally on Analog on the Pick-up menu.

An analog trigger pick-up commences when the analog channel selected as a
trigger reaches the value specified.

Figure 93
"Programme analog

pick-up" option on the
Pick-up menu
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The value of the trigger is defined using the box in the top section (in volts).

The analog channel is defined by making a selection from the SAD450/
SAD450M’s eight analog inputs. Here the user simply clicks on one of the eight
buttons representing the inputs.

There are three types of analog trigger, as follows:

1. Ascending means that the previous value of the trigger must be lower
than this value to activate the pick-up.

2. Descending means that the previous value of the trigger must be higher
than this value to activate the pick-up.

3. Both means that when a value equal to that of the trigger arrives in the
channel, the pick-up will activate.

To select the type of trigger, the user clicks on one of the three options in the
Type of trigger group.

The window allows the user to redefine the times.

Figure 94
"Programme analog

trigger pick-up"
window
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When the user clicks on Accept, a window appears to request confirmation of
the pick-up.

If all is well, this will disappear as soon as the programming has been validated
by the SAD450/SAD450M interface; otherwise a window will appear to indicate
a communications error.

Between programming of a trigger pick-up and the first reading of the data, an
icon appears on the status bar.

If the user wishes, he may display the pick-up whilst this is being carried out.

When the user clicks on Cancel, any changes made to the times will not be
reflected in the configuration and the window duly closes.

Digital trigger
To access this type of programming, the user clicks first on the Programme
pick-up option, then on Trigger, and finally on Digital on the Pick-up menu.

Figure 95
"Waiting for interface

response" window

Figure 96

Figure 97
"Programme pick-up -
digital trigger" option

on the Pick-up menu
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This type of pick-up commences when the digital channel selected changes in
accordance with the type of trigger defined.

The trigger channel is defined by indicating the number of the SAD450/SAD450M
digital input which is to be used. To do this, the user simply enters the number
in the box on the top right-hand side of the window.

There are three types of digital trigger, as follows:

1. Ascending means that the pick-up will be activated on the first ascending
flank arising in the trigger channel.

2. Descending means that the pick-up will be activated on the first
descending flank arising in the trigger channel.

3. Both means that the pick-up will be activated on the first ascending or
descending flank arising in the trigger channel.

To select the type of trigger, the user clicks on one of the three options in the
Type of trigger group.

The window allows the user to redefine the times.

Figure 98
"Programme digital

trigger pick-up"
window
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When the user clicks on Accept, a window appears to request confirmation of
the pick-up.

If all is well, this will disappear as soon as the programming has been validated
by the SAD450/SAD450M interface; otherwise a window will appear to indicate
a communications error.

Between programming of a trigger pick-up and the first reading of the data, an
icon appears on the status bar.

If the user wishes, he may display the pick-up whilst this is being carried out.

When the user clicks on Cancel, any changes made to the times will not be
reflected in the configuration and the window duly closes.

Aborting a pick-up

When a pick-up has been programmed, and for some reason the user no longer
wishes to carry this out, he may use the Abort pick-up option to cancel
programming of the SAD450/SAD450M interface.

To abort a pick-up, the user simply clicks on the Abort pick-up option on the
Pick-up menu.

Figure 99
"Waiting for interface

response" window

Figure 100
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The pick-up may likewise be aborted by pressing the Abort button
on the tool bar.

- If no pick-up has been programmed, the programme will show the next
window to advise the user with regard to the status of the SAD450/
SAD450M interface.

- Kaptoris always shows a verification window, and asks if the user is sure
he wishes to abort the pick-up.

If the user selects Accept, the pick-up is cancelled, whereas Cancel continues
with the pick-up.

N.B: If the pick-up had already commenced when the user aborts
the procedure, the SAD450/SAD450M interface allows him to
read any data picked up, but these may lack consistency.

Figure 101
"Abort pick-up" option

on the Pick-up menu

Figure 102
Warning window

Figure 103
Confirmation window
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Displaying a pick-up

This option displays the signals whilst their data are picked up by the SAD450/
SAD450M interface.

The display is carried out during the pick-up period, and the data appear on
screen, sample by sample.

To display the data, the user presses Display on the main menu.

If, when the user wishes to display the data, no pick-up is being carried out or
has been programmed, a warning window advises him of this situation.

If a pick-up is being carried out, a window appears to show the data being picked
up.

When the user clicks on Close window, the display window closes.

A message is displayed on the bottom left of the window to inform the user
when the pick-up has been completed.

Once the pick-up has been completed, the digital signals also acquire their final
format.

Figure 104
"Display" option on the

Pick-up menu

Figure 105
"Pick-up complete"

button
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This option is extremely useful when the user wishes to monitor the variation of
a signal over an undefined period of time.

When the user clicks on Continuous display on the Pick-up menu, an immediate
pick-up is automatically programmed with the configuration of inputs / outputs
and times defined. The display window then activates and the programme starts
to show the pick-up.

Once the analysis time has elapsed, the pick-up will reprogramme automatically
and the display window will initialise to show again the signals being picked up.

The loop ends when the user presses Close window on the display window.

The recommended minimum analysis time for this programme command is 4
seconds. Shorter times would make Kaptoris reprogramme SAD450/SAD450M
interface on a continuous basis.

N.B.: The user may read off the last pick-up programmed during
continuous display.

Reading data

To convert the data picked up into signals to allow the user to work with them in
Kaptoris, a data reading must be carried out. Kaptoris requests theSAD450/
SAD450M to send information with regard to the last pick-up, and interprets
this by converting it into signals which may then be processed and analysed.

To obtain data concerning a pick-up from the SAD450/SAD450M interface, the
user clicks on the Read pick-up data option on the Pick-up menu.

The user may also read the data by clicking on the Read button                    on the
tool bar.

Continuous
display

Figure 106
"Read pick-up data"

option on the Pick-up
menu
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If, when the user is reading the data, the set of signals is empty, an initial analog
signal display window is created automatically, with a maximum of eight signals
(for more information concerning signal display, consult Working with graphic
representation).

If, when the user is reading the new data, a set of signals already exists, the
system will request confirmation with regard to how to proceed by means of a
window which allows the user to choose between creating a new set of signals,
discarding the existing signals, or adding the signals to the existing set.

If the user wishes to add the signals, but the automatic naming option is not
activated, it is possible that some signal names are repeats. This window will be
shown for each repeat signal.

When the user clicks on Overwrite, the previous signal with this name will be
replaced by the new signal.

When the user clicks on Do not include the signal, the signal will simply not be
read and will not be included in the set of signals.

When the user clicks on Change name, he may use this window to change the
name of the new signal.

Figure 107
Confirmation window

Figure 108
Confirmation window



78 KAPTORIS.  Operator's manual

The user enters a new name in the box, clicks on Accept, and the new signal has
been renamed. If the user presses Cancel, the signal will not be included in the
set.

Testing the status of the SDA450 interface

This advises the user at any time of the status of the SAD450/SAD450M interface.

For the status of the interface, the user clicks on the Test interface status option
of the Pick-up menu.

 The user may also click on the Test button               on the tool bar.

Figure 109
"Change name of

signal" window

Figure 110
"Test interface status"
option on the Pick-up

menu
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Should the interface not respond, a message appears to advise the user that it
has not proved possible to communicate with the interface. This may happen if
the interface is not properly connected to the communications port or if it is
simply not plugged in.

The SAD450/SAD450M interface has three possible statuses, as follows:

1. No pick-ups have been programmed and the interface memory contains
no data for any pick-ups.

2. The interface is picking up data.

3. The interface has completed the last pick-up programmed, and the data
are stored in its memory.

In addition to the interface status, the window also shows the interface memory
in bytes, and its version.

Figure 111
"SAD 450 interface

status" window
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C H A P T E R

6

Results

This section covers the options for processing of signals and data.

The SAD450/SAD450M interface does not need to be present to use these
Kaptoris commands, since the operations are carried out using sets of signals
which may have been picked up immediately, or could be from a pick-up file.

Pick-up files

Kaptoris allows the user to save the configuration and the set of signals with
which he is working. He may also load a configuration and a set of signals
obtained on a previous occasion.

This allows the user to work with sets of signals in the absence of the SAD450/
SAD450M interface.

Working with no connection to the SAD450/SAD450M interface disables the
pick-up options, but not the options for analysis and processing of signals.

The pick-up files have a KPT extension.

Saving a pick-
up

When the user saves a pick-up in a KPT-extension file, this saves both the
configuration and the total set of signals.

Saving a new
document with

no name
1. Click on the Save button                or on the Save option on the File menu.

2. To save the document in a different folder, click on a unit other than the
Save in option, or double click on a different folder from the list.
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3. Write a new name for the file in the Name of file box.

N.B.: Long descriptive names may be used for files if the user so desires.

Saving an
existing

document
1. Click on the Save button                   or on the Save option in the File menu.

Saving a copy of
the document

2. Click on Save as in the File menu

3. Write a new name for the file in the Name of file box.

4. Click on Save.

Suggestion: To save the copy in a different folder, click on another unit of Save,
or click on a different name in the list of folders, or use both procedures.

Opening a
pick-up To open a Kaptoris file, proceed as follows:

1. Click on the Open button                      or on the Open option of the File menu.

2. In Search in, click on the drive, folder or Internet site which contains the
document.

3. In the list of folders, double click on the folders until the system opens
the folder containing your document.

4. Double click on the document you wish to open.

Working with graphic representation

Understanding
the signals

display window
These windows provide a graphic representation of data.

They can be of two types, depending on the type of signals displayed : digital or
analog. The window functions in the same fashion whatever the signal type.
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The digital signals are also displayed on the analog-type windows, with values
between 0 and 5 volts.

The maximum number of signals represented in this type of window is eight. The
right-hand side of the window shows the names of the signals, for ease of
identification.

When the user clicks the mouse’s right-hand button on the window, this menu
appears with zoom options and cursor activation options.

The same options are available on the tool bar, on the image buttons.

1. Zoom + enlarges the area selected by dragging the cursor.

2. Zoom -  returns the window to its original appearance prior to
activation of Zoom +.

3. Cursors activates the lower section of the window, highlighted in
yellow (for more information, consult Cursors in the manual).

Figure 112
"Signal display"

window

Figure 113
Energing menu

Figure 114
Graph representation

options
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By default, the signals are represented as a function of time, but a signal may be
represented as a function of another signal (for more information, consult
Selecting signals for display).

The appearance of the signals may be modified using the menu option Define
representation.

To select signals for display, click on Select signals from the Representation
option on the main menu.

Selecting the
signal to be

displayed
If the user is in a signals display window and wishes, or does not wish, to see
certain signals, he must choose the Select signals option on the menu, or click

the Select button on the tool bar.

A window then appears with two lists. The list on the right-hand side shows the
signals not included in the representation, whereas the left-hand list shows the
signals included.

For selection of a signal, the user moves the signals he wishes to display to the
right-hand side, and the signals he does not wish to see to the left-hand side.

Figure 115
"Select signals to be
displayed" window
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This window also allows us to eliminate signals. The lower box features the
signal shown on the X axis. By default all the signals are represented as a
function of time, but it is possible to represent a signal as a function of another
signal by selecting it from the pull-down list which appears when the box button
is clicked.

Eliminating
signals

The “Select signals to be displayed” window is used for selection of signals.

1. Use the mouse or the keyboard to highlight the signals you wish to
eliminate.

2. Click on the Eliminate button.

3. A message window will appear to request confirmation for elimination of
the signals.

4. The signals will be permanently eliminated when the user clicks on Accept.

Working with
cursors A cursor is an indicator as to the values on the X and Y axes at a specific point

on the graph. The values are shown on the table at the bottom of the screen.
They are defined by the position of the cursor, i.e., in accordance with the part of
the graph on which the user clicks the mouse.

Each display window has two cursors in different colours.

The cursors are extremely useful for comparison of values at different points
along the X axis.

Activating the
display window

cursors
There are three ways of activating the cursors for a window, as follows:

1. By clicking the right-hand button of the mouse on the display window,
and selecting the Cursors option.

2. By clicking the Cursor button on the tool bar.

3. By selecting the Cursors option on the Representation menu.



86 Kaptoris.  Operator's manual

 This activates the cursors on the signals display window in which the user is
working.

The lower section of the window will show the data for the cursors.

Disactivating the
display window

cursors

The cursors may be disactivated in two ways, as follows:

1. By clicking on the          button at the bottom of the display window.

2. By clicking on the Cursor button                   on the tool bar of the main
menu.

3. By clicking on the Cursors option on the Representation menu.

Using the display
window cursors

The blue cursor is positioned on the graph by clicking the right-hand button on
the mouse. It is shown as a blue line perpendicular to the X axis, positioned at
the clicking point.

The red cursor is positioned on the graph by clicking the left-hand button on the
mouse. It is shown as a red line perpendicular to the X axis, positioned at the
clicking point.

The table at the bottom of the window will show three values for each signal –
the value on the Y axis of the blue cursor, of the red cursor and the difference
between them.

If the user keeps the button depressed and the mouse pointer is moved over the
representation, the values update as the position changes.

N.B.: The direction keys may also be used to move the cursor over
the graph.
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Changing the
appearance of

the display
To change the appearance of a display window, select the Define representation
option on the Representation menu.

The following window appears:

In this window the user may modify the way in which the signals are displayed:

1. Changing the lines to dots in the Drawing of signals group.

2. Defining the size of the dots in the Size of dot box.

3. Activating or disactivating the automatic scale on both axes.

4. Activating or disactivating the grille on both axes.

5. If the automatic scale is disactivated, the user can manually define the
pass size and the maximum and minimum values for both axes.

Figure 117
"Configuration of

graphic representation"
window

Figure 116
"Define representation"

option on the
Representation menu
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Adding signals from a file

Signals may be added from a file to the set of signals with which the user is
working.

To carry this out, the user must have a set of signals and click on the Add signals
option on the File menu.

The system provides a typical dialogue box to allow the user to select any KPT-
extension file.

Should the file selected and the current set of signals not prove compatible
(their analysis and sampling times must be the same), an error message appears
on screen.

A window appears to allow the user to select the signals we wish to add to the
set from the file.

Figure 118
"Add file signals"

option on the File menu
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Once the signals have been selected, click on Accept.

If the name of one of the signals the user wishes to add is repeated within the
current set of signals, a window appears to allow the user to give it a new name.

When the user clicks on Cancel, the signal will simply not be included in the set.

If the user clicks on Accept, the signal will be included under the new name
written in the box.

Figure 119
"Select file signals"

window

Figure 120
"Change signal name"

window
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Eliminating signals

The signals may be eliminated on the same window on which the signals the
user wishes to view are selected. For information with regard to accessing the
window, consult the help section “Working with graphic representation”.

Creating a new display window

Kaptoris can show a large number of display windows simultaneously, and the
signals to be displayed from each of these may be selected.

Should the user wish to add a display window to existing windows, he merely
clicks on a button.

The user can create analog or digital display window, depending on the type of
signals to be displayed.

The digital signals may be displayed in analog format but, should the user wish
to see them in ‘0’ and ‘1’ logic values, they must be viewed in a digital display
window.

To create a new analog display window, the user clicks on the New analog
window option on the Window menu.

The user may also click on the Analog button                     on the tool bar.

To create a new digital display window, the user clicks on the New digital window
option on the Window menu.

Figure 121
"New analog window"
option on the Window

menu
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The user may also click on the Digital button                   on the tool bar.

The signals displayed initially are the first eight on the list.

The user may select the signals to be displayed. For more information, see
Selecting signals.

Organising the windows

The display windows may be organised within the space available on screen.
Their size and position may be changed manually, one by one or automatically.

The windows may be organised automatically in three different ways, as follows:

1. In cascade, by clicking on the menu’s Cascade option.

2. Horizontally, by clicking on the menu’s Horizontal option.

3. Vertically, by clicking on the menu’s Vertical option.

Figure 122
"New digital window"
option on the Window

menu
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The three options are to found in the Window menu.

Closing the windows

The active display window may be closed by clicking on the system icon           or
clicking on the Close active window option on the Window menu.

The user may also close all display windows created, using the menu’s Close
windows option.

Figure 123
"Cascade",

"Horizontal" and
"Vertical" options on

the Window menu

Figure 124
"Close active window"
option on the Window

menu
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Data table

The data tables show in detail the values of each sampling process for the
signals selected. The tables may be exported to text format and printed out.

To see the table, click on the Data table option on the Representation menu.

The user may also access the data table by clicking on the Table button                     on
the tool bar.

The user then selects the signals he requires. This is carried out by displaying
the following window, which allows him to select, or eliminate, signals within the
set.

Figure 125
"Close all windows"

option on the Window
menu

Figure 126
"Data table" option on

the Representation
menu
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If no signal is selected, and the user clicks on Accept, a warning message appears.

Once the signals have been selected and the user clicks on Accept, the following
window appears. The first row contains the names of the signals, whilst the first
column shows the number of the sample.

Figure 127
"Select signals to be
displayed" window

Figure 128
Data table window
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This window also allows the user to export signal data to text files by clicking on
Export to TXT file, and to print them out by clicking on Print table.

To close the window, the user clicks on the system icon         or uses Ctrl+F4.

Signals data

If the user wishes to know other characteristics of the signals, such as their
names or origin, he must click on the Signals data option on the main menu.

The user may also access the data table by clicking on the Data icon                    on
the tool bar.

The window shows information concerning the characteristics of each signal.

Figure 129
"Signal data" option on

the Representation
menu
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The Name box shows the signal whose data are being displayed. To select
another signal, the user clicks on the         button on the box.  A pull-down list
appears, allowing the user to select from all the signals in the set.

The name of a signal may be changed by clicking on             . The following
window appears, allowing the user to rename the signal.

The other data concerning the signal are as follows:

- The origin may be a signal picked up from the exterior or an output. The
signal could also come from the calculator or from an operation.

Figure 130
"Signal data" window

Figure 131
"Rename signal"

window
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- Depending on the origin, the bottom left-hand box will show data such
as the type of generator for a digital output, or the input number where
the signal was picked up. If the signal is from a calculator or a digital
input, this box will be empty.

- The bottom right-hand box shows the values of a number of calculations
which may be of interest to the user. In the case of an analog signal, the
maximum, minimum, mean and integral values are shown, and in the case
of a digital signal the number of ascending and descending flanks.

- The data on the top right-hand side are the same for any type of signal:
sampling time, number of samples, analysis time and type of signal  (analog
or digital).

To exit this window the user clicks on Accept.

The signals calculator

This option allows the user to generate new signals from those already in the set
of signals.

The calculator carries out calculations with analog and digital signals. It includes
the same operators as the operations window, and the difference lies in that the
signals generated by the calculator are isolated results. Each data reading
generates a signal for each defined operation, and this is not the case for signals
produced by the calculator.

The calculator is activated using the Signals calculator option on the
Representation menu.

Figure 132
"Signals calculator"

option on the
Representation menu



98 Kaptoris.  Operator's manual

The user may also access the data table by clicking on the Calc. icon                             on
the tool bar.

The calculator allows the user to operate with signals of the same type, i.e. he
may operate with analog or digital signals.

The type of calculator which appears when the signals calculator is activated
depends on the type of graphic representation with which the user is working.

- If the user is working with a graphic representation of digital signals, the
calculator activated will be a digital signals calculator.

- If, on the other hand, the user is working with a graphic representation of
analog signals, the calculator activated will be an analog signals
calculator.

Digital signals
calculator

This type of calculator allows the user to perform calculations among the digital
signals in the set of signals.

Figure 133
"Digital signals

calculator"
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The operations which can be carried out with the digital signals calculator are as
follows: OR, AND, XOR, XNOR, NOR, NAND and NOT.

The result of an operation between signals is another signal. Once the calculation
has been carried out, the user may select one of two procedures for the resultant
signal, as follows:

1. Give it a name and add it to the set of signals.

2. Continue to operate with the resultant signal and another signal
from the set.

The user exits the calculator by clicking on Exit calculator.

As of this moment, any signals generated in the calculator will be available in the
set of signals.

Operating with the digital calculator

1. Select a signal from the list of digital signals. The name of the signal
appears in the upper box, which shows the operations like a calculator as
they are defined.

2. Click on the button showing the operation you wish to carry out.

3. Should another operand be taking part in the operation, select another
signal from the list of digital signals.

4. All the operations buttons disactivate, and the Result button activates.

5. Click on Result to carry out the calculation for the operation defined.

6. The display shows the word “Result”. The Add to signal set button
activates.

7. If you wish to continue operations with the result, begin the sequence
again from step 2.

8. Click on the Add to signal set button to move the “Result” signal to the
set of signals.

9. A window appears requesting a name for the signal.

10. Click on Accept to add the signal to the calculator list and the set of
signals with which you are working.

N.B.: The AC button clears the display like a normal calculator. The
Ins and M buttons perform the memory functions of a normal
calculator.
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Analog signals calculator

This type of calculator allows the user to perform calculations among the analog
signals in the set of signals.

The operations which can be carried out with the analog signals calculator are
as follows: add, subtract, multiply, divide, filter, integral and derivate.

Operations may also be carried out between signals and constants.

The result of each operation between signals is another signal. Once the
calculation has been carried out, the user may select one of two procedures for
the resultant signal, as follows:

1. Give it a name and add it to the set of signals.

2. Continue to operate with the resultant signal and another signal
from the set.

The user exits the calculator by clicking on Exit calculator.

As of this moment, any signals generated in the calculator will be available in the
set of signals.

Figure 134
"Analog signals

calculator"
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Analog signals calculator

1. Select a signal from the list of analog signals. The name of the signal
appears in the upper box, which shows the operations like a calculator as
they are defined.

2. Click on the button showing the operation you wish to carry out.

3. Should another operand be taking part in the operation, select the second
operation signal or define a Constant.

4. All the operations buttons disactivate, and the Result button activates.

5. Click on Result to carry out the operation defined.

6. The display shows the word “Result”. The Add to signal set button
activates.

7. If you wish to continue operations with the result, begin the sequence
again from step 2.

8. Click on the Add to signal set button to move the “Result” signal to the
set of signals.

9. A window appears requesting a name for the signal.

10. Click on Accept to add the signal to the calculator list and the set of
signals with which you are working.

N.B.: The AC button clears the display like a normal calculator. The
Ins and M buttons perform the memory functions of a normal
calculator.

Reports

Kaptoris can print out reports which include the following:

- Graphic representation.

- Data table.

- Comments.

To access the reports window, click on the Print report option of the File menu.
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The user may also access the reports window by clicking on Print on the tool
bar.

The window shows the appearance of the page, and the position of the various
parts of the report on the page.

- The user may choose which parts of the report to print by selecting the
appropriate verification boxes from the Print options group.

Figure 135
"Print report" option on

the File menu

Figure 136
"Preliminary

presentation" menu
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- The Page group is used to select either horizontal or vertical mode for the
page.

- To see the properties of the printer, click on the Printer button
     , and the Windows printer dialogue box appears.

- Click on Print to print out the report.

- Click on Accept to close the window.

N.B.: If the user wishes to add personal data or data concerning the
pick-up, these may be included using the comments section.

Adding a comment

The user may add a comment to the pick-up to provide more data, or to add
personal data which may appear on the subsequent report.

To access the comment editor, click on the Comment option on the Pick-up
menu.

A window appears with a box for the user to write in comments, and a menu with
three simple options.

Figure 137
"Comment" option on

the Pick-up menu
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The menu commands are as follows:

- Clear deletes all items written up to this point.

- Open shows the comment on the pick-up.

- Save saves the changes made to the comment.

- Exit closes the window and, should any changes have been made which
have not yet been saved, the system provides the option of saving
before the comment window closes.

Working with texts

It is possible to insert short texts into the graph, and position these as required.

To insert an item into a text, click on Insert text on the Representation menu.

Figure 138
"Comment on pick-up"

window

Figure 139
"Insert text" option on

the Representation
menu
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A window appears with a box to write in the text to be inserted.

The user clicks on Accept, the text appears on the graph and may be positioned
anywhere by using the mouse to drag it to the required position.

If the user wishes to eliminate the last text inserted, he simply clicks on the
Delete last text option on the Representation menu.

If the user wishes to eliminate all text inserts from the graph, he clicks on Delete
all texts on the menu.

Figure 140
"Insert text" window

Figure 141
"Delete last text" option

on the Representation
menu



106 Kaptoris.  Operator's manual

Exporting

Kaptoris allows the user to export data belonging to pick-ups which may be
exported with graphic display as either Windows Bitmap (.BMP files) or Windows
Metafile (.WMF files).

It is also possible to send the graphic display to the clipboard by clicking on the
Export .BMP option, and then to clipboard on the File menu.

Detailed data for each sample and signal may be exported to text format (.TXT
files).

.BMP format
1. To export a signal display, there must be first be a signal display window.

Click on the Export .BMP option on the File menu.

2. A Save dialogue box appears. Write in the name you wish to give to the
BMP file.

3. Click on Accept.

Figure 142
"Delete all texts" option

on the Representation
menu



107Chapter 6.  Results

.TXT format
1. To export signal data, there must first be a set of signals. Click on the

Export .TXT option on the File menu.

2. A Save dialogue box appears. Write in the name you wish to give to the
TXT file.

3. Click on Accept.

.WMF format
1. To export signal displays, there must first be a signal display window.

Click on the Export .WMF option on the File menu.

2. A Save dialogue box appears. Write in the name you wish to give to the
WMF file.

3. Click on Accept.
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C H A P T E R

7

User interface

General description

The figure below shows the appearance of the main window for the Kaptoris
application:

The window is divided into the following sections:

- Menu, showing all the Kaptoris commands.

- Tool bar, consisting of buttons which carry out the most frequent
operations. Everything which can be carried out by clicking buttons on
the tool bar can also be performed using the menu.

- Signal visual display windows. Any windows of this type may be opened,
and they contain a graph section and a section of values which are
activated by the cursor.

Figure 143
Main window
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- Status bar, showing the date and time, with icons showing possible pick-
ups and a line to explain the meaning of some buttons when the mouse
arrow is positioned over them.

Menu

The following table shows all the menu commands and a brief description of the
operations performed by them.

FILE menu

Open Opens a Kaptoris .KPT extension file
Save Saves the signals and the configuration in the

file
Close Closes the current set of signals and clears the

configuration
Add file signals Adds new signals to existing signals from a

file
Print report Provides a pre-display of the report to be

printed out
Export BMP/ to file Exports graphic representation to a BMP file
Export BMP/ to clipboard Exports graphic representation to the clipboard
Exit Closes the application

CONFIGURATION Menu

Inputs/outputs Shows the configuration window for the inputs
and outputs (I/O) belonging to the SAD450
interface

Appearence of I/O window Shows a window where you can choose the
kind of interface you will work with.

Open configuration file Loads the configuration from a CFG file
Save configuration file Saves the current configuration in a CFG file
Save as … Saves a copy of the CFG file under another

name.

PICK-UP Menu

Test interface status Tests the status of the SAD450 interface and
shows the information

Programme pick-up/analog Programmes an analog trigger pick-up
trigger
Programme pick-up/digital Programmes a digital trigger pick-up
trigger
Programme pick-up Programmes an immediate pick-up
Programme delayed pick-up Programmes a delayed pick-up



111Chapter 7.  User interface

Display Displays the pick-up currently being performed
Continuous display Programmes and displays the pick-up

automatically until the user decides to halt the
process

Abort pick-up Aborts the pick-up programmed or being
performed

Pick-up data read Reads the SAD450 interface data and creates
the signals

Comment Opens the pick-up comment editor facility

REPRESENTATION Menu

Define representation Defines the style of the graphic representation
Select signals Selects the graphic representation signals
Signal data Views the general characteristics of the signals
Data table hows the table with all samples for each signal
Signals calculator Digital/analog calculator for most frequent

operations
Cursors Activates the cursors option for the active

graphic representation
Zoom + Enlarges the area selected on the graphic

representation
Zoom - Returns the graphic representation to its normal

appearance
Insert text Inserts a short text in the graphic

representation
Delete last text Deletes the last text inserted in the graphic

representation
Delete all texts Deletes all texts inserted in the graphic

representation

WINDOW Menu

New analog window Creates a new graphic representation window
with analog signals

New digital window Creates a new graphic representation window
with digital signals

Close active window Closes the graphic representation window
activated

Close all windows Closes all the graphic representation windows
Cascade Organises the windows in a cascade
Horizontal Organises the windows in horizontal format
Vertical Organises the windows in vertical format
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HELP Menu

Help topics Opens the Kaptoris help facility and shows its
contents

About Kaptoris Shows the Kaptoris information window

Tool bar

The tool bar contains a subset of the operations which may be carried out using
menu commands.

These buttons may be used to carry out the following operations:

Opens a pick-up file.

Saves the pick-ups’ data and configuration.

Prints out customised reports.

Configures the SAD450 interface inputs and outputs.

Tests the status of the SAD450 interface at any time.

Programmes an immediate pick-up.

Figure 144
Tool bar
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Reads the data which the SAD450 interface contains.

Aborts the pick-up being performed.

Selects the signals appearing on the active graphic representation.

Shows the characteristics of the signals.

Displays, prints out and exports data from signal sampling.

Displays values in accordance with cursors on graphic
representation windows.

Enlarges the graphic representation.

Returns the graphic representation to its original size

Creates a new graphic representation window for analog signals.

Creates a new graphic representation window for digital signals.

Provides access to the Kaptoris help facility.
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Extension of files

The Kaptoris application features three types of files, as follows:

1. KPT. Kaptoris files which include configuration and signals.

2. CFG. Configuration files.

3. TBA. Files containing digital or analog tables

Data may also be exported in various formats, as follows:

- BMP. Graphic representation to a Windows bits map.

- WMF. Graphic representation to a Windows meta-file.

- TXT. Sample data table to text file

Information windows

These windows provide a warning message, and normally have only one button,
Accept, which closes the window when it is clicked.

Warning windows

These windows show a message following an error, and normally have only one
button, Accept, which closes the window when it is clicked.

Figure 145
Information window

Figure 146
Warning windows
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Confirmation windows

These windows request confirmation from the user with regard to the next
operation to be carried out. Normally this type of window asks if the user wishes
to save the changes.

Exiting Kaptoris

The user can close the Kaptoris application in three ways, as follows:

1. By clicking on the system button             in the top right-hand corner of the
main window.

2. By clicking on the Exit option on the File menu.

3. Using the Ctrl+F4 key combination.

N.B.: If the last changes have not been saved, the programme allows
the user to save these before exiting.

Figure 147
Confirmation window

Figure 148
"Exit File menu" option
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Use of the help facility

The user may obtain help by following the normal procedure. He simply clicks
on Help topics on the main Kaptoris menu. He then clicks on the Contents file to
move around the help file’s contents table. He can enter the Index file to carry
out a topic search using the Help facility’s index of topics, or he can use the
Search file and its text search function to find specific words and phrases.

       The suggestions show information concerning the various items which
appear on screen. To see a suggestion relating to a dialogue box option, click on
the question mark and then click on the option. To see the name of a tool bar
button, place the mouse arrow over the button until the name appears.

Figure 149
"Help topics" option on

the Help menu
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C H A P T E R

8

Practicals

Practical 1

This practical will configure two inputs, two outputs and an operation. The
system will perform a delayed pick-up, and then display the data table. The
“Signal data” option is also involved in this practical.

The first step consists of configuring the inputs and outputs involved in the
configuration.

The user must activate digital input A1 and digital analog C1, and this is carried
out by clicking on the appropriate verification boxes.

With SAD450:

Figure 150
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With SAD450M:

The user now defines two outputs with the following data:

- Digital output W1

- Name : Saldig1

- Generator : Pulse train

- Delay time: 0 seconds

- Time at 1 (Ton): 100 milliseconds

- Time at 0 (Toff): 100 milliseconds.

Figure 151
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- Analog output Y1

- Name : SalAna1

- Generator: Step

- Delay time: 1 second
- Offset amplitude (Ao): -6 volts
- Step amplitude: 6 volts

Figure 152
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Once these two channels have been defined, the outputs section of the
“Configuration of inputs/outputs window” looks like this:

With SAD450:

Figure 153

Figure 154
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With SAD450M:

The user must now define an analog operation by clicking on the Analog
operations button. The operations window appears, and the operation to be
defined is as follows:

- Name: OpAna1

- Description : EntAna1 * -0.5

Figure 156

Figure 155
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The user then defines the times:

- Analysis time: 2 seconds

- Sampling times: 1 millisecond

- Number of samples: 2001

The configuration has now been completed, and the user clicks on Accept.

If you intend to use this configuration, it must be saved. Click on the Save
configuration option.

Now the user must prepare the connections for the channels which are to take
part in the pick-up. On this occasion the outputs will be connected to the inputs
as follows:

- SalAna1 to EntAna1

- SalDig1 to EntDig1

This time we are going to define a delayed pick-up, and so we click on Delayed
pick-up on the Pick-up menu. We must define a delay time of 2 seconds and
then click on Accept.

Figure 157

Figure 158
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After 4 seconds, if all is well, the pick-up data will be stored in the SAD 450’s
memory. Click on Read on the tool bar to transfer the signals to Kaptoris, which
displays a graphic representation window as follows:

The Signal data option on the Representation menu shows the origin of each
signal and other data of interest. The window appears with data such as origin,
times and a number of calculated values which will depend on the type of signal
selected from the pull-down list.

Figure 159

Figure 160
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To view data from each sample, the best idea is to consult the data table. When
the user clicks on the Table icon on the tool bar, a window appears to allow him
to select the signals whose values he wishes to display. It is extremely important
to select only signals of interest, particularly with regard to pick-ups with large
volumes of data, since the time required to generate the table increases in
proportion to data.

In this case it is not necessary to omit any signals. When the user clicks on
Accept, the data table appears.

Figure 161



125Chapter 8.  Practicals

Figure 162
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This window allows the user to export the table to a file, and to print it out.

To close the window, simply click on the          button in the top right-hand corner
of the window.

To complete this first exercise, we must save the results obtained in a file. We
click on Save, either on the tool bar or on the File menu.

If the user wishes to see the result of this exercise, the file is to be found in the
following directory: ‘KAPTORIS\Ejemplos\Ejemplo2.kpt’.

Practical 2

This practical generates “Table”-type analog and digital output signals. The
signals are read and stored in such a way as to allow the user to view them
together with the signals in the previous example.

The first step is to configure the outputs which are to take part in the pick-up.
For this example, we assume that example 1 has been loaded.

We must activate digital output W3 and analog output Y2, selecting in both
cases a Table-type generator and configuring it.

The tables are stored as text files. The first line shows the number of values of
which the table is composed, and then one value per line is entered (the values
must lie between +10 and -10 Volts):

How to create a table

- The table editor (for more information, consult “Table editor”) proves
useful when we wish to edit or modify existing tables. We can also create
new tables but, since this is carried out manually, there should be a small
number of values.

Example of a table with 5 values 
 

5 
1.2567 
1.0000 
0.1250 
0.0000 
0.1000 

 
 



127Chapter 8.  Practicals

- To create tables with many values (100 or more), it is advisable to use a
compiling facility and use the code to automatically save in a file the
values of the type of signal we wish to generate. The
“KAPTORIS\Ejemplos\tablas\” directory contains two small applications
which respectively implement an exponential signal and a digital signal.

- GenExpAna: This application uses a constant, the frequency of the
signal and the sampling time to generate a table-type file for the
function: y=exp(xt)-1.

- GenDigital: This application uses the frequency of the signal and
the sampling time to generate a table-type file for the signal in the
following format:

- In both applications, the number of points on the table is calculated in
accordance with the following formula (where fs = frequency of the signal
and tm = sampling time).

 Nº data in base = 1/(fs*tm )

To generate the two tables to be used, we will use the two sample executions:

- For analog output X2, we must create a table with GenExAna. The values
will be as follows:

- Name of the table file = TablaExp

- Signal constant (x) = 1.2

- Frequency of the signal (fs) = 0.5

- Sampling time (tm) = 0.001

- For digital output W3, we must create a table with GenDigital. The values
will be as follows:

- Name of the table file = TablaDig

- Frequency of the signal (fs) = 0.5

- Sampling time (tm) = 0.001

Figure 163
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Once we know the names of the files in which the tables are stored, we can
define the parameters of the outputs.

Configuring analog output X2

Figure 164
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Configuring digital output W3

Figure 165



130 KAPTORIS.  Operator's manual

Once both outputs have been configured, this is the appearance of the outputs
section in the inputs/outputs window:

With SAD450:

With SAD450M:

Figure 166

Figure 167
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The times to be configured are as follows

- Sampling time = 1 Msec.

- Analysis time = 2 Sec.

To carry out the pick-up, the user presses Accept to leave the configuration
window. He then clicks  on the Prog. icon on the tool bar. A window appears,
“Programming immediate pick-up”, and pick-up commences when he clicks on
Accept.

The next step, once the analysis time has elapsed, is to read the data in the
memory of the SAD450 interface. To do this, simply click on the Read icon on the
tool bar. The graphic representation which then appears shows the signals in
example 1, in addition to the new features, SalAna2 and SalDig3.

Figure 168

Figure 169
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Since it may prove cumbersome to view all the analog and digital signals together
(the digital signals have values of 0 and 5 Volts), the first thing to do is to display
only the analog signals on the current graphic representation. To do this, click
on the Select icon on the tool bar, and leave SalAna2, SalAna1 and PrimeraA
on the list of signals displayed. Click on Accept to see the signals more clearly.

Figure 170
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Figure 171
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To see the digital signals with logic values ‘1’ and ‘0’, we must move to a new
digital graph window. Simply click on the Digital icon on the tool bar and a new
graph appears showing only digital signals.

We use the Cursors option to obtain a specific value at a point on the graph
shown in the digital representation window. Position the mouse on the point
you wish to analyse, and the lower values table shows, for each signal, the time,
the X and Y value, and, if the two cursors available have been defined (red and
blue), the difference between them.

For this operation the cursors may also be moved using the direction keys on
the keyboard, with the same result.

Figure 172
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Finally, click on the Save option on the File menu, and save the file with a name
of your choice.

The file for this example is to be found in the ‘KAPTORIS\Examples/’ directory.

Practical 3

This practical performs pick-up and display of an analog signal.

The signal is displayed on screen during pick-up, and its values are not stored
in the memory.

The signal picked up must be generated in a unit or module external to the
programme, since in this example no output signals will be generated. A commercial
signal generator may be used.

We must first configure the analog input which will pick up the signal from the
exterior. We must configure analog input C3, or any other we wish to use.

Figure 173



136 KAPTORIS.  Operator's manual

If any inputs with another configuration are activated, these must be disactivated.

Before carrying out the pick-up, we define the times with the following values:

- Sampling time : 1 Msec.

- Analysis time : 5 Sec.

With SAD450:

With SAD450M:

When we click on Accept, the configuration is completed. The next procedure is
to programme an immediate pick-up, and so we click on Prog. on the tool bar and
on Accept on the “Programming immediate pick-up” window.

Figure 174

Figure 175
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Now we must select the Display option on the Pick-up menu.

A window opens to show the signal being picked up by analog input 1, or any
other selected.

The signal in the example was generated using an oscilloscope and its
characteristics are as follows:

- Type of signal  : senoidal

- Frequency: 1Hz

- Amplitude: 6 volts (peak to peak).

Once the analysis time has elapsed, in this case 5 seconds, the entire signal is
displayed.

The user may stop display of the pick-up at any time by clicking on Close
window.

When the display window has closed, the user may read off the data from the
SAD450/SAD450M interface, since the last pick-up is stored here.

This example is to be found in the KAPTORIS\Ejemplos \Ejemplo3.KPT directory.

Figure 177

Figure 176
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Practical 4. Calculator and filters

In this practical, we will work with analog operations and the signals
calculator. Another aim of this practical is the use of filters in the case of
senoidal signals of differing frequency.

Firstly, we must obtain three senoidal signals. The signals will have frequencies
of 3, 5 and 10 Hz respectively. The signals may be obtained in several ways:

- They may be generated via analog outputs.

- They may be picked up via analog inputs using exterior signal generators.

The first method is as follows:

The following outputs must be configured with the values set out below:

- Analog output Y1

- Name: Seno3

- Senoidal analog generator

- Delay time = 0 seconds

- Offset amplitude = 0 volts

- Senoid amplitude = 2 volts

- Frequency = 3 Hz

- Phase shift = 0 degrees

- Analog output Y2

- Name: Seno5

- Senoidal analog generator

- Delay time = 0 seconds

- Offset amplitude = 0 volts

- Senoid amplitude = 4 volts

- Frequency = 5 Hz

- Phase shift = 0 degrees
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- Analog output Z1

- Name: Seno10

- Senoidal analog generator

- Delay time = 0 seconds

- Offset amplitude = 0 volts

- Senoid amplitude = 5 volts

- Frequency = 10 Hz

- Phase shift = 0 degrees

We will now configure an analog operation which consists of the sum by pairs
of the analog outputs. The signals generated by the operations will be used a
posteriori when we apply filters using the calculator.

Click on the Analog operations button on the “I/O Configuration” window to
access the window for definition of analog operations.

The lists of operands show the three outputs defined. If these do not appear, we
must check that the verification boxes for the three outputs are activated and
that their generators have been properly defined.

Three operations will be defined, as follows:

- Suma3-5 = Seno3 + Seno5

- Suma3-10 = Seno3 + Seno10

- Suma5-10 = Seno5 + Seno10

Here we will explain how to define the first operation, whilst the two remaining
operations will be defined following the same procedure:

1. Select Seno3 from the Operand 1 list

2. Click on the “+” operator button

3. Select Seno5 from the Operand 2 list

4. Write the name Suma3-5 in the Name box

5. Click on Add

6. The Suma3-5 operation should now appear on the Operations list, and
the expression “(Seno3 + Seno5)” on the Descriptions list.
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We define the remaining operations in the same way. When we have completed
the process, the operations window should look like the window below. Should
any of the operations be incorrect, we can delete them by selecting them and
clicking on Delete.

Now we must configure the analysis time and the sampling time. The following
are the values to be entered:

- Sampling time = 1 millisecond

- Analysis time = 1 second

- Number of samples = 1001

Click on Accept, and the configuration window closes. Should the programme
have detected an error, a warning window will open. In this case it is advisable to
re-examine the entire configuration as defined.

Next we carry out the pick-up, clicking first on the Prog. button to bring up the
window for immediate pick-up. Click on Accept. The pick-up is programmed and
is carried out on the SAD450/SAD450M interface.

Figure 178

Figure 179
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The next step is to read the data for the signals. Click on the Read icon on the
tool bar to obtain the output signals and those created by operations. The graph
which appears should be as follows:

To ease our work with the signals, we will divide them between two analog
display windows. For this operation we must create a new window by clicking
on Analog on the tool bar.

A window appears on screen which is identical to the previous window. We use
the Select option on the tool bar to select signals Seno3, Seno6 and Seno10 for
the first window. The other window must display signals suma3-5, suma3-10 and
suma5-10.

Finally, to improve window visibility we should click on Horizontal in the Window
menu. This organises the windows more efficiently within the work space.

The screen should have the following appearance:

Figure 180

Figure 181
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We must now activate the signals calculator by clicking on the Calc. icon on the
tool bar. The calculator provides a list on the left-hand side of all the analog
signals in the signals set - in this case, all of them.

The calculator will be used in this case to apply filters. The signal with which we
will be working will be the sum of signals Seno3, Seno5 and Seno10. We obtain
the sum of these three signals as follows:

1. Select signal Seno3

2. Click on the + button

3. Select signal Seno5

4. Click on the Result button

5. Click on the + button

6. Select signal Seno10

7. Click on the Result button

8. Click on the Add to signal set button

9. Write in ‘Total’ in the name window

10. Click on Accept

Figure 182
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11. Now the Total signal should appear on the list of signals.

The first filter to be applied is a low pass filter with a cut-off frequency of 9 Hz.
This means that the magnitude of values whose frequency exceeds 9Hz will be
eliminated. When this filter is applied to the Total signal, the resultant signal
should be similar to Suma3-5.

We proceed as follows for application of the filter:

- Select the Total signal

- Click on the Filter button

- In the “Filter” window:

- Select the type of filter Low pass

- Write “9” in the Low frequency box

- Click on Accept

- Click on Result

- Click on the Add to signal set button

- Write the name “Pbajo9” and click on Accept

To display the result, we must create another analog window, where only the
Pbajo9 and Suma3-5 signals will be displayed. It will be observed that the
signals are similar.

Figure 183
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The following signals may be compared by way of an exercise:

- Calculated signal

- Signal over which we apply the filter = Total

- Filter for band

- Low frequency = 4

- High frequency = 6

- Suma3_10 signal

- Calculated signal

- Signal over which we apply the filter = Total

- High pass filter

- Cut-off frequency = 9

- Seno10 signal

Figure 184

Figure 185
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- Calculated signal

- Signal over which we apply the filter = Total

- Band pass filter

- Low frequency = 4

- High frequency = 11

- Suma5_10 signal

To save the operation carried out, click on Save and give the KPT file a name.
This ensures that it will be available to work with at a later date.

Figure 186

Figure 187
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A N N E X

A

SAD450 Interface software

Introduction

To programme the SAD450 interface without using KAPTORIS, we must be
familiar with its commands. This annex also provides a brief description of the
operating structure of the SDA450 interface’s internal software, and how
communications are carried out with the PC.

Structure of the main programme

The structure of the SAD450 unit’s main programme is as follows:

Figure 188
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The programme is located in a loop in stand-by mode for events. The events to
which the programme responds are as follows:

- An alarm is triggered: the alarm bit moves to 1 when an alarm triggers.
The list of possible alarms is as follows:

1. Pick-up start alarm.

2. Programmed trigger alarm.

3. Extra-fast pick-up programmed alarm.

4. Pick-up finish alarm.

5. Fast-count start alarm.

- A character reaches the serial line: this event is shown on the
cont_carac_recibidos meter. Every time a character arrives the meter
moves forward, and so we know how many characters remain to be read.
If a command is detected during a reading of the characters, the system
moves to deal with the command.

Communication with the PC

Communication with the PC is carried out via an RS-232C interface, using the
XON/XOFF protocol at 115200 Bauds.

XON/XOFF is an extremely simple protocol which controls only the flow through
the RS232. When the receiver realises that its reception buffer is filling up, it
sends an XOFF to advise the transmitter to stop sending information. As the
receiver reads through the buffer information, it releases it in such a way that,
when it sees that it is ready to receive again, it can then send an XON to allow
communication to continue.

The next figure shows the connections of the unit to the PC.

SAD     PC(9-pin interface)

-1 1

TxD-2 2- RxD

RxD-3 3- TxD

GND-5 5- GND
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SAD PC(25-pin interface)

1 8

TxD-2 2- RxD

RxD-3 3- TxD

GND-5 5- GND

Communication between the PC and the unit is carried out by commands. Each
command is composed of the following:

1. Command Nº: Whole, in ASCII code.

2. Parameters: All the parameters required by the command will be in ASCII
and separated by commas. This field can be zero and there may be no
parameters.

3. End of command: The ASCII character “#” will indicate the end of the
command.

Figure 176 shows the protocol to be followed for communication with the unit.
This protocol must be observed for sound operation of the unit.

Some examples of commands are as follows:

1. “4,a#” è Reading of digital inputs.

2. “5,v,128#” è Writing digital outputs.

The unit’s response to a recognised command is the recognition character “&”
followed by the response if the command requires this. The response information
sent by the unit consists of the following:

1. Fields of information separated by commas “,”.

2. The ASCII character “#” to indicate end of response.

If the computer detects an error in the information received, it will send the
command to the unit again.

Example of a response:

Command: "4,a#"
Responde: "&23#"
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Commands

Before specifying the commands we must understand a number of points which
will be dealt with below.

The SAD450 data acquisition unit has 4 analog outputs and 8 inputs, and 16
digital inputs and outputs.

The analog inputs may be differential or normal. If they are differential, each
input pair will form a differential input, and so in differential mode there are 4
inputs and not 8.

Each input will be assigned an identification code to distinguish between them.

Figure 189
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The following are the identification codes for inputs in normal mode:

Identification code Channel

A High byte, digital inputs
B Low byte, digital inputs
C 1st channel of analog inputs
D 2nd channel of analog inputs
E 3rd channel of analog inputs
F 4th channel of analog inputs
G 5th channel of analog inputs
H 6th channel of analog inputs
I 7th channel of analog inputs
J 8th channel of analog inputs

In the case of the differential inputs:

Identification code Channel

K 1st channel of analog inputs
(Channel C – Channel D)

L 2nd channel of analog inputs
(Channel E – Channel F)

M 3rd channel of analog inputs
(Channel G – Channel H)

N 4th channel of analog inputs
(Channel I – Channel J)

O Fast-count input 1
P Fast-count input 2

The outputs will also have identification codes. The following are the digital
outputs’ identification codes:

Identification code Channel

U High byte, digital outputs
V Low byte, digital outputs
W 1st channel of analog outputs
X 2nd channel of analog outputs
Y 3rd channel of analog outputs
Z 4th channel of analog outputs
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The following section teaches us how to use the unit’s commands.

Testing
presence and
version of the

unit

This command allows us to detect whether or not the unit is connected. If it is
connected, we are informed as to the current version and size of the RAM.

Format of the command

- Command number: 1

- Parameters: None

- End of command: #

Format of the response

- Recognition of the command: &

- If there is no recognition, this means that the unit is disactivated.

- Parameters:

1. Version of the unit. Format of the version: a whole number and two
decimals (e.g. 1.02)

2. Available RAM memory for pick-ups and for tables for signals to be
generated. The value shows the maximum number of programmable
bytes.

- End of the response: #

Example:

Example of the request for unit presence and version test.

“1#”

Response:

“&1.01,63487#”

Status of the
interface This command informs the user as to the status of the interface.

Format of the command

- Command number: 2

- Parameters: None

- End of command: #



153Annex A.  SAD450 Interface software

Format of the response

- Recognition of the command: &

- Parameters:

1. Interface status:

0 → No pick-up has been programmed.

1 → A pick-up has been programmed, but has not yet started.

2 → Picking up and/or generating data.

3 → Pick-up and/or generation completed. If data have been picked
  up, they will be available in the unit’s memory.

- End of the response: #

Example:

Example of interface status request.

Configuration
of the analog

inputs This command allows the user to configure the analog inputs. The maximum
number of channels to be configured is 12 (8 single-ended channels and 4
differential channels). If the user attempts to configure more than 12 channels,
the command will not be recognised.

Format of the command

- Command number: 3

- Parameters:

1. Channel identifier: C-D-E-F-G-H-I-J-K-L-M-N. Channels C..J are normal
analog channels, and channels K..N are analog channels in differential
mode.

Command “2#”

Response “&1#”

A programmed pick-up has not yet started
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2. Range of the input signal:

0 → 10V< V >+10V

1 → 5V< V >+5V

2 → 2V< V >+2V

3 → 1V< V >+1V

4 → 0.5V< V >+0.5V

5 → 0.2V< V >+0.2V

- Sections 1 and 2 will be repeated for all the unit’s channels. When the
unit is initialised, all channels will acquire the configuration by default
(±10V).Once the unit has been initialised, the configuration cannot be
changed unless the user gives this command.

- End of command: #

Format of the response

- Recognition of the command: &

Example:

Example of the configuration of the analog inputs.

Reading the
input channels This command allows the user to read the input channels, digital or analog.

Format of the command

- Command number: 4

- Parameters:

1. Channel identifier: A..N. Channels A and B are digital, channels C..J
are analog channels in single-ended mode, and channels K..N are
analog channels in differential mode.

Channel C and D (single-ended) with � 10V inputs and

channel L (differential) with � 0.2 V inputs

“3,C,0,D,0,L,5#”

Response “&”
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- Parameter 1 will be repeated for each of the input channels to be read.

- End of command: #

Format of the response

- Recognition of the command: &

- Parameters:

1. Value of the reading: 0.255 for the digital channel and -2048..2047 for
the analog channels.

- This parameter will be repeated for each input.

- End of response: #

Example:

Example of reading the digital inputs.

Writing the
output

channels Format of the command

- Command number: 5

- Parameters:

1. Channel identifier: U..Z Channels U and V are digital, and the rest are
analog.

2. Value of the writing. 0.255 for the digital channel and -255..255 for the
analog channels.

- Points 1 and 2 will be repeated as many times as channels which the user
wishes to write.

- End of command: #

Format of the response

- Recognition of the command: &

Reading of inputs A,B and C “4,A,B,C#

Response “&1,16,2308#”
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Example:

Example of writing the analog outputs.

Trigger pick-up
programming This command allows the user to programme a pick-up which begins following

an external trigger signal. The external trigger may be either analog or digital. If
outputs are configured, signals will also be generated. Prior to this, the tables
must be loaded.

Format of the command

- Command number: 6

- Parameters:

1. Nº of data to be picked up or generated. This parameter will determine
the number of samples for the pick-ups and the length of the table for
generation of the signals.

2. Number of input channels which take part in the pick-up 0..9. If a 0 is
entered in this parameter, this means that no signal will be picked up.

3. Identifier of the channels: A..N. Channels A and B are digital, channels
C..J are analog channels, and channels K..N are analog channels in
differential mode.

Parameter 3 will be repeated for each channel. Should the number of
inputs be 0, this parameter will not be sent.

4. Nº of output channels which are to be used to generate the signals.
Should this parameter be 0, this means no 0..5 signals will be sent.

5. Identifiers of the output channels through which the signals are to be
generated.
U..V. Digital output channel.
W..Z. Analog output channels.

6. Table data. If the data correspond to an analog channel, the range of
values will be -2048 to 2047. If they correspond to a digital channel,
these will be -255 to 255.

Writing channels U and Z “5,U,200,Z,245#”

Response “&”
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Parameters 5 and 6 will only be valid if an output has been programmed.
These parameters will be sent for each output. As for the inputs, if the
number of output channels is 0, these parameters will not be sent.

7. Trigger channel: A..N. Channels A and B are digital, channels C...J are
analog channels, and channels K..N are analog channels in differential
mode.

8. Trigger value/ trigger bit. Should the trigger channel be an analog
channel, this parameter will contain the value of the analog signal
upon which the trigger activates (-2048..2047). However, if the channel
is digital, this parameter will contain the bit nº which activates the
trigger 0..7.

9. Status during which the trigger is activated. This parameter will have
different meanings, depending on whether the trigger is digital or
analog, as follows:

If the trigger is digital:

0 →   Descending flanks. When the signal moves from 1 to 0.

1 →   Ascending flanks. When the signal moves from 0 to 1.

2 →   Ascending and descending flanks. When the signal moves from
   1 to 0 or from 0 to 1.

If the trigger is analog:

0 →  When the signal moves down from the pre-set value.

1 → When the signal moves up from the pre-set value.

2 → When the signal is other than the pre-set value.

10. Identifier of the sampling time.

0 →  µSeg

1 →  mseg

2 →  Seconds

11. Sampling time: 1..65535.

- End of command: #

Format of the response

- Recognition of the command: &
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Example:

Example of programming a trigger pick-up

Immediate/
delayed pick-

up
programming

This command allows the user to programme a delayed pick-up. This type of
pick-up begins after a period defined by the user has elapsed. If the period set is
zero, pick-up will begin as soon as the command is received. If outputs are
configured, signals will also be generated.

Format of the command

- Command number: 7

- Parameters:

1. Nº of data to be picked up or generated. This parameter will determine
the number of samples for the pick-ups and the length of the table for
generation of signals.

2. Number of input channels taking part in pick-up 0..9. If a 0 is used in
this parameter, this means that no signal will be picked up.

3. Identifier of the channels: A..N. Channels A and B are digital, channels
C..J are analog channels, and channels K..N are analog channels in
differential mode.

Parameter 3 will be repeated for each channel. Should the number of
inputs be 0, this parameter will not be sent.

4. Nº of output channels which will be used to generate the signals. If
this parameter is 0, this means that no signal 0..5 will be generated.

5. Identifiers of the output channels via which the signals will be
generated.
U..V. Digital output channels.
W..Z. Analog output channels

Channels B, D and H participating. The

trigger is analog, and occurs when the

input in channel F exceeds 243.

No signal is generated.

The sampling time is 1 millisecond, and

number of samples is 50.

“6,50,3,B,D,H,0,F,243,1,1,1#”

Response “&”
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6. Table data.
Parameters 5 and 6 will only be valid if an output has been programmed.
These parameters will be sent for each output. As in the case of the
inputs, if the number of output channels is 0, these parameters will
not be sent.

7. Delay time. 0..65535 seconds. (18h 12 min 15 seconds)

8. Identifier of the sampling time.

0 → µSeg

1 → mseg

2 → Seconds

9. Sampling time: 1..65535.

- End of command: #

Format of the response

- Recognition of the command: &

Example:

Example of programming a delayed pick-up.

Cancelling the
pick-up This command allows the user to cancel the pick-up activated. When this is

cancelled, all data pertaining to the pick-up are stored in the memory. If a new
pick-up is programmed, these data will be lost.

Format of the command

- Command number: 8

- Parameters: None

- End of command: #

Programming of a pick-up delayed for

20 seconds in 1 channel with 50

samples, and a sampling time of 10

milliseconds.

“7,50,1,C,0,20,1,10#”

Response “&”
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Format of the response

- Recognition of the command: &

Reading the
pick-up data:

information
This command allows the user to read off the sample data. This command does
not delete the data from the memory.

If no input is being picked up in the pick-up programmed, the command returns
the number of samples generated to date.

Format of the command

- Command number: 9

- Parameters: None

- End of command: #

 Format of the response

- Recognition of the command: &

- The response to this command will depend on whether or not pick-up
exists.

A  →  Pick-up does not exist

- Recognition of the command:&

- Parameters: None

- End of response:#

B  →  Pick-up exists. Response will be different, in accordance with whether
    or not an input channel is being picked up:

B.1 → Picking up data:

- Recognition of the command:&

- Parameters:

1. Nº of samples picked up to date. If this value is zero, this
means that the pick-up has been programmed but has not yet
commenced.

2. Information data.

- End of the response:#
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B.2  → Only generation is taking place, with no pick-ups.

- Recognition of the command:&

- Parameters:

1. Nº of samples generated to date. If this value is zero, this
means that generation has been programmed but has not yet
commenced.

- End of the response:#

Example:

Reading the
last sample This command allows the user to read the last datum taken from the pick-up

taking place. It also provides information with regard to the sample number.
If no analog input is being picked up, this command will return the number of
samples generated to date.
This command will be used to display data from the pick-up being carried out.

Format of the command

- Command number: 10

- Parameters: None

- End of command: #

Format of the response

A → A pick-up exists with inputs.

- Recognition of the command: &

- Parameters:

1. Sample number. This value shows the number of samples sent. If
this value is 0, the other parameters are not sent. This value shows
that there is no pick-up activated or, if it has been programmed,
that it has not yet begun.

Command “9#”

Response “&2,50,78#”
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2. Value of the last sample. This parameter will be repeated as many
times as there are channels taking part in the pick-up.

- End of response:#

B → No input is being picked up. Only the signal is being generated.

- Recognition of the command: &

- Parameters:

1. Number of samples generated to date. If this value is 0, this means
that there is no pick-up activated or, if it has been programmed,
that it has not yet begun.

- End of response:#

Example:

Example of reading when there is no pick-up activated.

Example of reading when there is a pick-up activated with two channels.

Fast-count
inputs This command allows the user to carry out speedy counting of pulse trains.

All commands used for pick-ups covered up to this point are also valid for fast-
count inputs.

Format of the command

- Command number: 11

- Parameters:

1. Nº of samples to be picked up or generated.

2. Nº of inputs. This parameter shows the number of fast-count inputs
which are to be programmed (1-2).

3. Identifier of the inputs: O-P

Command “10#”

Response “&0#”

Command “10#”

Response “&25,-1305,135#
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4. Type of command: This parameter is used to distinguish the way in
which the count begins.

0 → Immediate

2 → By trigger.

5. Trigger channel (A-B). The trigger channel will be digital.

6. Trigger value.(0..7). Corresponds to the position of the bit which will
act as a trigger.

7. Trigger status.

0 → Descending flank.

1 → Ascending flank.

2 → Flanks.

Parameters 5, 6 and 7 will only be valid if the command type is trigger.

8. Type of count: This parameter allows the user to distinguish between
the operating mode for the fast-count inputs.

0 → Nº of pulses per time unit. We may use this count mode to
determine the frequency. The maximum count frequency
depends on the number of inputs programmed.

  1 → Time between pulses: This count mode is used to determine the
speed of any object which produces pulses while in movement
(encoder etc). In this case we only have one input channel.

9. Identifier of the sampling time:

1 → millisecond

2 →  seconds

10. Sampling time: 1..65535

- End of command: #

f
100Khz

Nº entradamax =

f 1.28e 3Hz, f 50Khzmin max= - =
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Format of the response

- Recognition of the command: &

Example:

Example of programming for an immediate fast-count input.

Activation of
signals This command allows the user to activate the generation of signals previously

activated. If we attempt to activate a signal which has not previously been
activated or even defined, either because no pick-up command has been sent, or
because this has been received but no signal has been associated with the
identifier of the channel requested by this command, the command will return
recognition of the command but will not carry out any operations.

Format of the command

- Command number: 12

- Parameters:

1. Number of signals to be activated. (1..6).

2. Identifier of the output channel to be activated.(U..Z)
This command will be repeated for each signal to be activated.

If the identifier of the channels is U-V:

3. Nº of bits to be activated 1..8

4. The number showing the position of the bit within the digital output
byte 0..7

This parameter will be repeated for each of the bits to be activated.

- End of command:#

Format of the response

- Recognition of the command:&

Immediate programming of the fast-

count input “0”, count type “Nº of

pulses per unit of time”.

The sampling time is 10 milliseconds,

and the number of samples is 30.

“11,30,1,o,0,0,1,10#

Response “&”
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Disactivation
of signals This command allows the user to disactivate the signals. When a signal is

disactivated, the channel moves to 0v. When the signal is reactivated, the channel
will load the value it would have had if the signal had not been disactivated. If
the user attempts to disactivate a signal which has not been activated (e.g.:
waiting for a trigger) or which has not been defined either because the pick-up
command has not yet been received, or because this has been received but no
signal has been associated with the identifier of the channel requested by this
command, the command will return recognition of the command but will not
carry out any operations.

Format of the command

- Command number:13

- Parameters:

1. Number of signals to be disactivated. (1..6)

2. Identifier of the signal to be disactivated.(U..Z)

This parameter will be repeated for each signal to be disactivated.

If the identifier of the channels is U-V:

3. Nº of bits to be disactivated.1..8

4. The number showing the position of the bit within the within the
digital output byte 0..7

This parameter will be repeated for each bit to be disactivated.

- End of command:#

Format of the response

- Recognition of the command:&

Example

Example of disactivation of analog channel W and of bits 0 and 1, digital channel
V.

Disactivation of analog channel W and of bits

0 and 1 in the digital channel V

“13,2,w,v,2,0,1#”

Response “&”
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